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\ IGV supports many different file formats ]

BAM

BED

BedGraph

bigBed

bigWig

Birdsuite Files
broadPeak

CBS

CN

Custom File Formats

Cytoband
FASTA
GCT

genePred

GFF/GTF

GISTIC

Goby

GWAS

IGV

LOH

MAF (Multiple Alignment Format)
MAF (Mutation Annotation Format)
Merged BAM File

MUT

narrowPeak

PSL

SAM
Sample Info (Attributes) file
SEG

SNP

TAB

TDF

Track Line
Type Line
VCF

WIG
chrom.sizes

For more info see: www.broadinstitute.org/igv/FileFormats
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IGV data sources

’) Google Cloud

\ amazon )
webservices™ ’

—7 =

HTTP server GenomeSpace

Local files

i View local files without uploading }

i View remote files without downloading whole dataset }
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Citing IGV
To cite your use of IGV in your publication:

James T. Robinson, Helga Thorvaldsdéttir, Wendy Winckler, Mitchell Guttman, Eric S. Lander, Gad Getz, Jill P. Mesirov. Integrative
Genomics Viewer. Nature Biotechnology 29, 24—26 (2011)

Helga Thorvaldsdéttir, James T. Robinson, Jill P. Mesirov. Integrative Genomics Viewer (IGV): high-performance genomics data
visualization and exploration. Briefings in Bioinformatics 14, 178-192 (2013).

Development of IGV is made possible by funding from the National Cancer Institute, the National Institute of General Medical
Sciences of the National Institutes of Health, and the Starr Cancer Consortium.

IGV participates in the GenomeSpace initiative, which is funded by the National Human Genome Research Institute.
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Overview

Downloads

The Integrative Genomics Viewer (IGV) is a
——} hlgh performance visualization tool for
N N ion of large, ir
Jsmws genomic datasets. It supports a wide variety of
data types, including array-based and next-generation
sequence data, and genomic annotations.

Citing IGV

To cite your use of IGV in your publication:

James T. Robinson, Helga Thorvaldsdéttir, Wendy Winckler,
Mitchell Guttman, Eric S. Lander, Gad Getz, Jill P.

Mesirov. Integrative Genomics Viewer. Nature
Biotechnology 29, 24-26 (2011)

Helga Thorvaldsdéttir, James T. Robinson, Jill P.
Mesirov. Integrative Genomics Viewer (1 !) high-
perfonnanoe genomu:s dat visuali; and

Download the IGV desktop application and
igvtools.
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Install IGV

Options for installing and running IGV:

1. (Mac only) Download and run the Mac applcation; or

2. (Windows) Dx load and run the xtracting archive; or

3. (All systems) Use the Java Web Start buttons (Mac users: see below for limitations); or
4. (All systems) Download the binary distribution and run IGV from the command line.

Note: IGV 2.3.x requires Java 7. Users with Java 6 (JRE 1.6) should first try to upgrade Java to the latest version.
If this is not possible you will need to run a 2.2.x version available in the archive.

Download

Mac

Mac App

Download and unzip the Mac App archive, then double-click the IGV application to run it. The Download
application can be moved to the "Applications” folder, or anywhere else. Mac App

Windows

Download
Windows Package

NOTE: for 64-bit windows only. For 32-bit windows use the 750MB launch button
below.

. Download the Windows package and execute the self-extracting archive.
. It will prompt you for a location to extract the folder, choose anywhere you like (e.g. your
home folder).

1
2

3. On completion, open the new folder.

4. Double-click the file "igv.bat", it might appear as just "igv" depending on your settings.

Java Web Start (All Platforms)
The buttons below use Java Web Start (JWS) to install and launch IGV directly from our web site.

*Mac Users: The Java Web Start option does not work for some users due to security settings. The recommended solution
is to use the bundled Mac App from the link above. Alternatively you can try to work around this by right-clicking on the
buttons and saving the "jnip” file, then right-clicking on the saved "jnlp" file and select "Open With > Java Web Start™.

Chrome: Chrome does not automatically launch the Java Web Start files by default. Instead, the launch buttons below will
download a "jnip" file. This should appear in the lower left corner of the browser. Double-click the downloaded file to run, or
if on a Mac right-click and select "Open With > Java Web Start"

or

Windows users: To run with more than 1.2 GB of memoary you must install 64-bit Java Most Windows installs do not
include 64-bit Java by default, even if the op is 64-bit. A g to use the 2GB or greater launch
options with 32-bit Java will result in the error "could not cleate virtual machine®.

& Launch & Launch & Launch

Launch with 750 MB Launch with 1.2 GB Launch with 2 GB Launch with 10 GB

Java Web Start

Maximum usable memory Maximum usable memory For large memory
for Windows OS with 32- for 32-bit MacOS. machines with 64-bit Java.
bit Java.

or

Download

Binary Distribution
. - . s
Binary Distribution
Download and unzip the binary distribution archive in a folder of your choosing. IGV is launched Download
from a command prompt - follow instructions in the "readme" file. To launch igv on Mac or Linux Binary Distribution

platforms use the shell script "igv.sh”. On Windows use "igv.bat".
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IGV user interface basics

Hands-on exercise

« Select reference genome
« Load data from IGV hosted data server
« Navigate

From whole genome view
to base pair resolution

Zoom in / out

Scroll / pan View neighboring regions

Jump to locus Enter coordinates or name




IGV user interface basics

Hands-on exercise
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GV user interface b

Hands-on exercise
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IGV user interface basics

Hands-on exercise

[ See handout ]




Select the reference genome

The genome drop-down menu is

in the upper left corner File Genomes View Tracks Regions
| JoN
Select Human hg18 ) | Humanhgl8 :) [ chr1 :]

CTTT I T T 177
p36.23 p36.12 p3




Load data

S8 Genomes View

Load from File...
Load from URL...
Load ImoMm DAS...
Load from Ga4gh...

select O Available Datasets

| Available Datasets
| | Annotations (hgl8)
|| Breast Cancer (METABRIC) (D)
| | The Cancer Genome Atlas (i)
| Copy Number Alterations Across Human Cancers (1)

C
>
New Session... [
Open Session... >
Save Session... >
>
>
>
>

Save Image ...

Exit

open f || Body Map 2.0 (lllumina HiSeq)

and v |MJI Basics (Encode)

] GM12878 H3K27ac
/ (] GM12878 H3K27me3
select ] GM12878 H3K36me3

| | GM12878 H3K4mel
> | | SNP Validation




Load data
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From whole genome view
to base pair resolution

Zoom in / out

Scroll / pan View neighboring regions

Jump to locus Enter coordinates or name




Navigate
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Navigate

View whole select or | click
genome ‘1’
| Human hg19 | AN ol

View whole

select or | enter or | click

chromosome ¢ / /
| Human hg18 ¢< chrl >‘<T chrl 5 ( 1 ) ) 3




Navigate

click & drag

Zoom in to area

swept out in ruler %! p3|€|12I : I;i3.4.|3 : p333 p31.1 22.
- o—>
nb 20 mb 40 mb 60 mb 80 mb 1
| | | | I | | |
Zoom in on area g Zoom out
of interest
Fn.‘_h_.__-_-.LL‘_h_ﬂ_lh alt-click
[0- 25
double-click __@__u
Zoom in or out using the
“railroad track” [=] e i




Navigate
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Navigate
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Reference sequence

Click anywhere on the sequence to see a 3 frame translation.
| lk

Sequence —) AGGTCAGGAGTCT

By default the sequence for the forward strand is shown.
I [[]

|Sequenoe -)l”GAGGTCAGGAGTCT

Click the arrow on the left to reverse the strand.

| ]
Sequence L

TCCAGTCCTCAGA




More basics — loading data

Other common ways of loading data
» Files > Load from File
* Files > Load from URL



More basics — loading data

Other common ways of loading data
» Files > Load from File
* Files > Load from URL

[ Try loading from URL.: }

3 i cenomes view | 1) Select Files > Load from URL
5 2) Enter
—  oadfomDAs.. ™ http://www.igv.org/workshops/March2017/signal.tdf
Load from Ga4gh... 3) CIle “OK”
New Sessic?n... ‘
il OR|
—  SaveImage ... - 1) In a web browser, navigate to
Exit http://www.igv.org/workshops/March2017

T

2) Drag the file signal.tdf and drop it onto the
|GV window




More basics — track options

[ Right-click popup menu} = track specific options menu

Common options
« Change track name, color, height
 Remove track

For quantitative data tracks: Data Range
« Set to an explicit range
« Enable log scale
« Enable autoscale
« Select multiple tracks and enable “group” autoscale

For quantitative data tracks: Data Display:
« Change between bar chart, line plot, point plot, heatmap

« Select multiple tracks and enable “overlay tracks”
l
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More basics — track options
Right-click popup menu = track specific options menu

Common options
« Change track name, color, height.
 Remove track

For quantitative data tracks: Data Range
« Set to an explicit range

« Enable log scale

« Enable autoscale

« Select multiple tracks and enable “group” autoscale

For quantitative data tracks: Data Display:
« Change between bar chart, line plot, point plot, heatmap

« Select multiple tracks and enable “overlay tracks”
l
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More basics — data details popup

00 IGV
Human hg19 B ot B chr1:143273,252-183,218567 Go B « » o o= = | =
p36.31 p36.13 p35.3 p34.2 p32.3 p31.3 p311  p223 p21.3 pl13.3 pl12 ql1 ql2 qll. q q23.3 q q253 q31.2 q32.1 q32.3 q42.11 q42.3 q44
39 mb
150 mb 160 mb 170 mb 180 mb
| | | | | | | |
[0-25
GM12878 H3K27ac
[PETY T Li 1 Ak
[0-25 CM12878 H3K27ac
GM12878 H3K27me3 Data scale: 0.0 - 25.0 -
haad ol - ~r Value: 6.44793 at position 156501258 = A
[0-25 Window function: mean
GM12878 H3K36me3
PRy | S
0-25) —
GM12878 H3K4me1
_LI‘L-_.I_—--. - ada ok sl FI | T i I Jl "

By default, a “data detail” window pops up as the
the cursor hovers over a data element in a track



More basics — data details popup

Change the popup behavior by clicking on the yellow balloon icon.
Options are (1) On hover (2) On click (3) Never

00
Human hgl9

B B} chr1:143273,252-183,218567 Go Ft « » @ [ T =]

IGV

p311  p223 p21.3 pl13.3 pl12 ql1 ql2 qll. q q23.3 q q253 q31.2 q32.1 q32.3 q42.11 q42.3 q44

p34.2 p32.3 p31.3

p3631  p3613 p353

GM12878 H3K36me3

GM12878 H3Kd4me1

39mb
150 mb 160 mb 170 mb 180 mb
| | | | | | | |
[0-25
GM12878 H3K27ac
| TN ebd. i - . -i 1 ll.l —
0-25 GM12878 H3K27ac
GM12878 H3K27me3 Data scale: 0.0 - 25.0 -
e~ Value: 6.44793 at position 156501258 = I
[0-25 Window function: mean

By default, a “data detail” window pops up as the
the cursor hovers over a data element in a track



More basics — the igv folder

In your home folder, IGV creates a folder named igv to store:

igv.log file
* Logs IGV activity and error messages
« If you send us a bug report or help question, we may ask for a
copy of this file

 To start a fresh log, you can delete or rename this file
(but not while IGV is running)

prefs.properties file
« Stores all the preference you set in View > Preferences so
they are remembered across IGV sessions

* You can reset all preferences by deleting or renaming this file
(but not while IGV is running)

genomes folder

« Stores info about the genomes you’ve loaded — for the
genomes dropdown menu.



Viewing Multiple Regions



Viewing multiple regions

multi-locus or split-screen view

S OO IGV
Human hg18 D chrl6 =N [ | Go ﬁ‘<\>|@’|ﬂ]’;¢’@‘ ElvrviBeeeeeeeeiineennn =

chri2 chr16

chri2
EEEE 5 | _|SEZ  EIEE EiE B N ESEiSESEEEE | ISES NI S NSE BN W B 0 e . B e Em e s

gﬁ chrl2:40739052-41147391 chrl2:52642358-52648797 chrl6:8121350-13070296
@z
E¥E
©0-25 - 25 - 25)
GM12878 H3K27me3
FTT7o ) RSVEY - . P
©0-25 ©-25 ©-25

GM12878 H3K36me3
N VORI YTV T T T W T S VU S ¥ | U W | S | TN
0-25) ©0-25 0-25

GM12878 H3K4ame1

025 -2 025
GM12878 H3K4Ame2
J;J.M_J.&L._LJ..L_LJA.._.L_-L_ e S S | .._.u_llu_ ..*_JLL_A‘LMJMMMLJ[.

[l + b - HHEE || S ECHHERH1|  EAEHHHE -

GXYLT1 YAF2 ZCRB1 PPHLN1 PRICH HOTAIR TMEM114 GRIN2A TEKT5 TNP2 GSPT1 CPPED1

RefSeq genes

108M of 253M

A

6 track(s) currently loaded | chr12:41,126,570 i |




Viewing multiple regions

multi-locus or split-screen view

®no GV
T : chri6 S Go ﬁ‘<‘>|’n’}r{’@‘ (=R e
chr12 chri12 chr16
T T4 T T T T - T I T [ [ T I BT < S N T BT
gﬁ chrl2:40739052-41147391 chrl2:52642358-52648797 chrl6:8121350-13070296
@z
E¥E
0-25 -2 0-25
GM12878 H3K27me3
Aabacdn. 1 vy - . ok
©-25

- 25) [0-25)
GM12878 H3K36me3
N VORI YTV T T T W T S VU S ¥ | U W | S | TN
©-25 ©-25 ©-25
GM12878 H3K4me1

0-25 o0-25 ©-25
GM12878 H3K4Ame2
JJJ.M...L..L._LJ..L_LJA.._.L_-L_ |l .._.l.l_lﬂjl_ ..*_LL_A‘LMJMMMLJ[.

| | |

Locus 1 Locus 2 Locus 3

RefSeq ganes H + e - HHE | S NCHHERH]| A
GXYLT1 YAF2 ZCRB1 PPHLN1 PRICH HOTAIR TMEM114 GRIN2A TEKTS TNP2 GSPT1 CPPED1
i | 108M of 253M y

6 track(s) currently loaded | chr12:41,126,570




Multiple regions — search box

Enter multiple loci or features in the search box

8006
[Human hgl8

[ o [ e

J———
pis33 p13.2 p13.12  pl23 pl2.1 pii.2 pll.1




Multiple regions — search box

Enter multiple loci or features in the search box

800
[Human hgl8

[ o [ e

J———
pis33 p13.2 p13.12  pl23 pl2.1 pii.2 pll.1

For a more persistent list of regions, use Regions of Interest



Multiple regions — “regions of interest” tools

For a more persistent list of regions, use Regions of Interest

Toregions:

(1) Use the[Region of Interest tool}

- Click on the tool icon in the tool bar
- Click twice in the data panel to specify the region boundaries



Multiple regions — “regions of interest” tools

For a more persistent list of regions, use Regions of Interest

Toregions:

(1) Use the Region of Interest tool
- Click on the tool icon in the tool bar
- Click twice in the data panel to specify the boundaries

(2) Use the[Region Navigator}
- Navigate to the new region
- Select Regions > Region Navigator
- Click Add to create a region from the current view

@ [ ] Regions of Interest
Show All Chrs Remove

Chr Start End Description

chr3 144545504 162173002

chré 103217470 103518846

chré 28840214 28855876

chr9 118984382 126275089

View v Zoom to Region

Search Clear Search




Multiple regions — “regions of interest” tools

For a more persistent list of regions, use Regions of Interest

Toregions:

(1) Use the Region of Interest tool

- Click on the tool icon in the tool bar

- Click twice in the data panel to specify the boundaries
(2) Use the Region Navigator

- Navigate to the new region

- Select Regions > Region Navigator

- Click Add to create a region from the current view

(3)[Import a file of pre-defined regions

- Prepare a .BED file containing the region definitions
- Select Regions > Import Regions



Multiple regions — “regions of interest” tools

For a more persistent list of regions, use Regions of Interest

Tomultiple regions of interest you defined:

Use the Region Navigator
- Select Regions > Region Navigator

- Select 2 or more regions
- Click View

Regions of Interest

[ NON |
Show All Chrs Add

Remove

Description

Chr Start

_
chr6 103217470 103518846
chr6 |  28840214] 28855876 |
chro | 118984382 126275089 |

v| Zoom to Region

Clear Search

Search



Viewing multiple regions

To go back to the standard, single-region view:

« double-click on a region label — or —
* right-click and select Switch to standard view

000 IGV.
Human hg18 3] [chri6 10 Go| | « | » | [ x| R e
chr12 chr12 chr16
(T O T T O T T o [ T i o o« [ [ B | B[
£ < chr12:40739052-41147391 chr12:52642358-52648797 chr16:8121350-13070296
Yo
323
[0-25) 0
Tme3
e - il ol e e dboub iy . . —
[0-25)

78
[0-25) ._[0 25)
_MJ-LM_ML S P S ——
[0-25) [0-25) [0-2:
8 H3K4me2 | I ' J- l
Y P el - J;A.._..L_-J-_-.




more about loading
Reference Genomes



Genome menu

File Genomes View Tracks Regi
| _NON )

The genome drop-down menu
is in the upper left corner of
the IGV window.

The genome menu is short when you first install IGV.

But IGV hosts dozens of genomes and you can load other genomes too.



More hosted genomes ——————

Selected genomes will be added to the
genome dropdown list.

Filter:

To get more genomes from the GV server: et

HIV-2
Horse (equCab?2)
Human (1kg reference, b36)

(1) Select More from the genome menu Haman 37
Human Adenovirus C

to See the Complete IiSt Human Herpesvirus 4, Type 1

Human Herpesvirus 4, Type 2

Human hgl6
X X N Human hgl7
File Genomes View Tracks Region Human hg18
Human hg38

. . Human Mito (NC_012920)

Human respiratory synctial virus
L. major Friedlin
chr3 L. major Friedlin (v4.0)
M. oryzae (mg8)
Macaca fascicularis (CE_1.0)
Maize (B73 4a.53)
Maize (ZmB73 5a)
Mouse (129S1/Svim))
Mouse mm10
Mouse mm7
Mouse mm8
Mouse mm9
Mycobacterium TB (CD1551)
N. Meningitidis (FAM18)
N. Meningitidis (MC58)
N. Meningitidis (Z2491)
N. crassa OR74A (NC10)
Neurospora crassa (v3)
0. Sativa (release 6)
O. Sativa (release 6.1)
O. Sativa (release 7)
Opossum (monDom5)
P. falciparum 3D7 (V9.0)
P. patens (V 1.2)

Human hgl19

p26.1 p24.3

Download Sequence
OK Cancel



More hosted genomes ——————

Selected genomes will be added to the
genome dropdown list.

Filter:

To get more genomes from the GV server: et

HIV-2
Horse (equCab?2)
Human (1kg reference, b36)

(1) Select More from the genome menu Haman 37
Human Adenovirus C

to See the Complete IiSt Human Herpesvirus 4, Type 1

Human Herpesvirus 4, Type 2

Human hgl6
X X N Human hgl7
File Genomes View Tracks Region Human hg18
Human hg38

. . Human Mito (NC_012920)

Human respiratory synctial virus
L. major Friedlin

chr3 L. major Friedlin (v4.0)

M. oryzae (mg8)

Macaca fascicularis (CE_1.0)
Maize (B73 4a.53)

Maize (ZmB73 5a)

vim])
Mouse mm10

Mouse mm8

Mouse mm9

(2) Click on entry in the list e oy
b) N. Meningitidis (FAM18)

N. Meningitidis (MC58)

e.g. Mouse mm10 N. Meringicis 72491

N. crassa OR74A (NC10)

Neurospora crassa (v3)

0. Sativa (release 6)

O. Sativa (release 6.1)

O. Sativa (release 7)

Opossum (monDom5)

P. falciparum 3D7 (V9.0)

P. patens (V 1.2)

n hgl9

p26.1 p24.3

Download Sequence
OK Cancel



More hosted genomes ——————

Selected genomes will be added to the
genome dropdown list.

Filter:

To get more genomes from the GV server: et

HIV-2
Horse (equCab?2)
Human (1kg reference, b36)

(1) Select More from the genome menu Haman 37
Human Adenovirus C

to See the Complete IiSt Human Herpesvirus 4, Type 1

Human Herpesvirus 4, Type 2

Human hgl6
. N N Human hgl7
File Genomes View Tracks Region Human hg18
Human hg38

. . Human Mito (NC_012920)

Human respiratory synctial virus
L. major Friedlin

chr3 L. major Friedlin (v4.0)

M. oryzae (mg8)

Macaca fascicularis (CE_1.0)

Maize (B73 4a.53)
Maize (ZmB73 5a)
p26.1 p24.3 vim))

Mouse mm8
Mouse mm9

(2) CIiCk On entry in the IiSt, Mycobacterium TB (CD1551)

N. Meningitidis (FAM18)
N. Meningitidis (MC58)

e.g . Mouse mm 10 N. Meningitidis (Z2491)

N. crassa OR74A (NC10)
Neurospora crassa (v3)
O. Sativa (release 6)

(3) Optionally select o st o

Opossum (monDom5)

Download Sequence \ 207 150
‘ | Download Sequenc
Do not download the . o
sequence today!

n hgl9




More hosted genomes ——————

Selected genomes will be added to the
genome dropdown list.

Filter:

To get more genomes from the GV server: et

HIV-2
Horse (equCab?2)
Human (1kg reference, b36)

(1) Select More from the genome menu Haman 37
Human Adenovirus C

to See the Complete IiSt Human Herpesvirus 4, Type 1

Human Herpesvirus 4, Type 2

Human hgl6
X X N Human hgl7
File Genomes View Tracks Region Human hg18
Human hg38

. . Human Mito (NC_012920)

Human respiratory synctial virus
L. major Friedlin

n hgl9 chr3 L. major Friedlin (v4f s .
J v onmse mas) | File  Genomes View T
Macaca fascicularis
Maize (B73 4a.53) f| “= =
Maize (ZmB73 5a) ! j
p26.1  p24.3 o HUman hgl19
q:Mouse mmlOB Mouse mm10
Mouse mm8 MOre___
Mouse mm9 - 1

(2) Click on entry in the list, eosaceram T8

N. Meningitidis (FAM18)
N. Meningitidis (MC58)

e g ] Mouse mm 10 N. Meningitidis (Z2491)
N. crassa OR74A (NC10)
Neurospora crassa (v3)

0. Sativa (release 6)
(3) Optionally select 0. Sava Gelonte 7
Opossum (monDom5)

Download Sequence P. falciparum 3D7 (V9.0)

P. patens (V 1.2)

Download Sequence

(4) Click OK Cancel




Loading other genomes

File BelNZGInEEM View Tracks

| Load Genome from File...
' | Load Genome from URL...

Load Genome From Server...

Create .genome File...

Manage Genome List...

i

Regio

) -

Use Genomes menu
to load genome from
an indexed FASTA file



Loading other genomes

File BeEllelil-x

| Load Genome from File...
| Load Genome from URL...

View Tracks

Load Genome From Server...
Create .genome File...

Manage Genome List...

i

Regio

T

Use Genomes menu
to load genome from
an indexed FASTA file

(1) Use samtools faidx command to create .fai index file
See github.com/samtools/samtools for info about samtools

(2) If no index file found, IGV will try to create the index upon load.




Load genome from file

Hands-on exercise

[ See handout ]




Load genome from file

Select Genomes > Load Genome from File and open .fasta file.

m View Tracks Regio

[ Load Genome from File...
Load Genome from URL...
Load Genome From Server...

Create .genome File...

Manage Genome List...

N -




Load gene annotation from file

Select Files > Load from File
and open annotation file (e.g. BED, or GTF)



Load gene annotation from file

Select Files > Load from File
and open annotation file (e.g. BED, or GTF)

) Genomes Genome Browser Tools Mirrors Downloads My Data Help About Us

Table Browser

Use this program to retrieve the data associated with a track in text format, to calculate intersections between tracks, and to retrieve
DNA sequence covered by a track. For help in using this application see Using the Table Browser for a description of the controls in this
form, the User’'s Guide for general information and sample queries, and the OpenHelix Table Browser tutorial for a narrated presentation
of the software features and usage. For more complex queries, you may want to use Galaxy or our public MySQL server. To examine
the biological function of your set through annotation enrichments, send the data to GREAT. Send data to GenomeSpace for use with
diverse computational tools. Refer to the Credits page for the list of contributors and usage restrictions associated with these data. All
tables can be downloaded in their entirety from the Sequence and Annotation Downloads page.

clade: Mammal [J genome: Human [J assembly: Mar. 2006 (NCBI36/hg18) [

group: Genes and Gene Predictions E track: RefSeqGenes E add custom tracks track hubs
table: refriat a describe table schema

region: © genome . ENCODE Pilot regions ' position chr1:1-247249719 lookup  define regions

identifiers (names/accessions): pastelist  upload list

filter: create

intersection: create

output format: BED - browser extensible data ) Send output to ) Galaxy ' GREAT ) GenomeSpace
output file: refseq_chri.bed (leave blank to keep output in browser)

file type returned: © plain text ~— gzip compressed

get output summary/statistics

http://genome.ucsc.edu/cgi-bin/hgTables



Load genome from file

Hands-on exercise

[ JON | IGV
chrl.fasta B o B o Go it « » T = =2 | SR =+
246 mb
nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb
| | | | | | | | | | | | | | | | | | | | | | | |
RefSeq Genes ST I L OO OO T T T T L U (OREURNN 0 W VN
11L1 PDPN SYF2 GRIK3 AGBL4 NFIA LRRIQ3 LMO4 SNX7 CSF1 ANKRD20A12P CD48 F5 ABL2 RGS18 LRRN2 RRP15 COG2 FH

This will be the starting point
for the next exercise.

2 tracks hr1:175,796,819 24M of 1,007M




Removing genome from list

Genomes > Manage Genome List

m View Tracks Regio

Load Genome from File...
Load Genome from URL...

Load Genome From Server...
[ —

Create .genome File...

Manage Genome List...

| 3




Removing genome from list

Genomes > Manage Genome List

m View Tracks Regio

O @® Manage Genome List

Drag and drop genomes to change

Load Genome from File... their order in the genome list.
Load Genome from URL... o §§Iea an..d press deleteh’ o Sl
Load Genome From Server. e RN IR

B Human hg19

) Mouse (mm10)
Create .genome File... Human hg18
chrl.fasta*

Manage Genome List... ﬁ

| 3

 Remove genomes from list
« Rearrange list

*Sequence on local machine

Add From Server Remove
 Add to list
Save Cancel
Do not remove chrl.fasta now. T

We’re using it for the next exercise.




Removing genome from list

Genomes > Manage Genome List

m View Tracks Regio

Load Genome from File... ,
Load Genome from URL... o
Load Genome From Server...

Create .genome File...

Manage Genome List... ﬁ

1 ]

 Remove genomes from list
« Rearrange list
« Addto list

O @® Manage Genome List

Drag and drop genomes to

change

their order in the genome list.

Select and press delete, or
"Remove", to remove them.

click

Human hg19
Mouse (mm10)
Human hgl8
chrl.fasta*

*Sequence on local machine

Add From Server

c

Note: IGV can get confused if you delete a local genome file
from the file system but not from the IGV menu

Remove

Cancel




Viewing Next Generation
Sequencing (NGS) Data



Viewing alighments

Whole chromosome view

e0o IGV
Human hg18 BEE: 1#] chn Go £t <« » m o= = = A e

[T T T 17T T T N [y o~
p36.23 p36.12 p343 p33 p321 p31.1  p22.2 p21.1  pl13.1 ql2 q21.1 q23.2 q243 q253 q31.3 q32.2 q42.11 q43

- 246 mb -

nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb

Coverage ~y I I I | I | I I I | I | I I I | I | I I I | I I

NA19240 SLX (YRI daughter) Co| "%
age

NA19240 SLX (YRI daughter) < Zoom in to see alignments. ’

Zoom in to see alignments

RefSeq genes I O O ORI O 1 O 1O | Y SR SR OOV N O O

28269 KAZN SYF2 SFPQ STIL CBA AK4 CRYZ UOX DR1 RNPC3 NRAS NR_033189 IFI16 XCL2 ABL2 FAMSC PKP1 RD3 HHIPLZ RBM34 NLR

4 tracks loaded |[chr1:95,509,957 I |[185M of 266M




iewing alig

nments

Zoom in to view alignments

800 IGv
Human hg18 %) (chni 8] chr1:95,625,439-95,649,303 |Go Tt « » @ [ X (2 Enmnginin &
Q7 21 G227 G241 a2 3Ll q3ET G323 q421l qa23  qad
23kb
95,626 kb 95628 k0 95,630 k0 5632k 95,634 k0 95,63 kb 5638 kb 95640 k0 95642 k0 95,644 K 95,646 kb 95,648 kb
1 1 1 1 1 1 1 1 1 1 I 1 1 1 1 1 1 1 1 1
o]
overage 1 | e I\ L
g—
.
Aligned |J.
RefSeq genes.
J4 tracks loaded [[ehrt:95,634,860 | | laam of 3970




Viewing alighments

Zoom in to see more detail

IGV - Session: /Users/helga/igv_session.xml

%) chr1:95,637,533-95,642,339

Go

7 «

@O xR

Sl =+

Bases that do not match |
the reference sequence fha ! . dihitha
are highlighted by color e S s e
| ‘ 1 ‘ I ‘ ‘ ‘: I ‘ n ‘I | E ] | ] II I‘I I i\ I “ I
I I \II ! o} I [‘ | I HI \}H
| 11 | 11 [ I\I H| I : : 1 : }u} I
Il I I | } . 1 ‘\ mn I I ! I\ | 1 { T
I | I N : ! I } }I\H
I I ] | i 1 II I I I‘I I {u] .
H | | o ‘I i \[HI ‘ l I | :I ‘ | ‘
| I . | ‘\ 1 H l 1 : ] | T II\ } ‘I‘I‘H
|| I | I m | (1] ] I I ‘\‘
I I | f 1 I r H‘ T I II \}
” I I ‘ \II ] i ] ! ! \II‘ |
||[ |l| || || Ii | . : I |'\ =\J | I“ i\ ]
[ || | i : ' I || : ‘ L | I : |
I l | T I‘ | 11
|u|||| LAl }
| 1 | 1 g B
|| | | : [ | ] 1l I} [
J4 tracks loaded [fenr1:95,638,557 Il |3t of




Viewing alighments

800

IGV.

("Human hg18

) (chr1

%) chr1:95,625,439-95,649,303 G Fft « » @O & QP E @ =

[CITT B T T TTTT T [ I T T -F- T -~ T W W0 W o NN T [ NN
p3623  p3612 p35T  p3al  p322  p3l2 p223 p2L3 pI33 pI2 ai2 a2l q22  q241 G252 a3l a321 q323 4211 q423  add

526 kb

8 kb

23kb
830 kb 834 95,636 kb 95,638 kb 95,640 kb 95,642 k0 95,644 kb 95,646 kb 95,648 kb

Coverage track indicates
loci with large number of
mismatches

NA19240 SLX (YRI daughter)

me

RefSeq genes

l4 tracks loaded

[enr1:95,634,860

|[244m of 397M




Viewing alighments

Zoom in to see more detail

8 no IGV - Session: /Users/helga/igv_session.xml
[Human hg18 %) (chr1 1) chr1:95,638,013-95,638,360 Go Bt « » @O 5 12 = NI IRIRTRTRTNIND]

E:m:mmm
P3623  p36i2 p3sd p3dl  p322  p3l2 p223 P23 pi33  pl2 Gz  q2i1 q22 G241 G252 a3Ll G321 q323 qa2il qd23  qdd

348 bp

95,638,100 bp. 95,638,200 bp 95,638,300 bp
1 1 ! 1 1 |

NA19240 SLX (YRI daughter) Col
aga

Sequence -

RefSaq genes

J4 tracks loaded [fenr1:95,638,054 Il |[p3am of 397M




Viewing alighments

Read mapping quality = 0




Viewing alighments

Zoom in to see more detail

fno IGV - Session: /Users/helga/igv_session.xml
("Human hg18 BEE 3] chr1:95,638,056-95,638,095 Go Bt « » @O & 1 Sl &
&mwm
P36.23  p36a2 p35d p3al  p322  p3l2 p223 p2l3  pis3  pl2 Qi2 G211 q22 q241 G252 q3L1 G321 q323  qa211 q423  qaa
40bp
95,636,060 bp 95,638,070 bp 55,638,080 bp 95636090 bp
1 1 1 | 1 1
NA19240 SLX (YRI daughter) Co| |©*® |
= |
- |
G G G 1
c |
o c |
Low-quallty base calls are - |
: |
¢ |
0 a c |
A c |
aint, semi-transparen - |
) - — |
c |
c |
c |
— |
c ; |
3 1
c |
c c T c T T T |
¢ |
¢ |
c C |
~ c c c C A |
- c
c A
c
c
c
c
c
c
c
c ¢
c
c
Cc z
c
c = <
¢ 3
Sequence - €C A G GT G T T CATGT GG AGAG GGG GACCTGATSGTTT GATCT T A
RefSeq gense
J4 tracks loaded [fenr1:95,638,070 Il |[p3om of 397M




Viewing alighments

Zoom in to view alignments

[XeYe) IGV.
Human hg18 ) [chr %) chr1:95,625,439-95,649,303 G Fft « » @O r QP i =

How far do you need to
zoom in to see the alignments?

4

30 -or- Set a different
kb | threshold in Preferences

* Higher value = requires more memory
* Low coverage files =» ok to use higher value
* Very deep coverage files =» use lower value



Viewing alighments

0o IGV
Human hg18 BRETH [%3) chr1:95,625,439-95,649,303 G Fft « » @O x Q1 Elonnf &
3623 p3612 p35d  p3al  p322  p3L2 p223 p!L} pi33  pl2 qi2  q2i1 q22 q241  q25.2 q3L.1 Q321 q323 q4211  q423 qdd
23 kb
ss28k0 sseazk0 P sk ssea0ko sseaz k0 ss.e46 k0 oo

95,628 kb
|

95,630 kb 95,636 kb
| |

95,644 kb
|

k]

NA19240 SLX (YRI daughter) Cof |
age

9 (!

For ve

ry deep coverage files: use low visibility threshold val

ue

NA19240 SLX (YRI daughter)

or limit the depth

Downsampling

=

M Downsample reads

Max read count: 100 per window size (bases):

50

RefSeq genes.

J¢ tracks loaded [fent:95,634,860

| laam of 397




Viewing alighments

[ Human hg18

Iy

chrl:95,625,439-95,649,303

» @ O = 2

p36.23 p36.12 p35.1 p34.1 p32.2 p31.2 p223 p!1.3 p133  pl2

Eleeeeeeeeegeeeen

1 | chrl
95,626 kb
| |
-9

down_ | daughter) Co| (

sampled

NA19240 SLX (YRI daughter)




Viewing SNPs

Hands-on exercise

« Load alignments from whole genome sequencing
* View sites where SNPs were called
« Sort and color to highlight patterns

[ Follow along ]




Viewing SNPs

Hands-on exercise

. omes  View Click File > Load from File

1 Load from URL...

- adiomsener.. —  Navigate to IGV folder that was
P o pre-installed on the computer,
New Session... | and then to Data / snps
Open Session...
Save Session... 2
= Savelmage ... e Open
- NA12878.SLX.sample.bam  not the .bai file
and

snp_calls.bed

Note: This assumes you successfully loaded
the genome in the previous exercise.



Viewing SNPs

Hands-on exercise

246 mb
inb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb
| | | | | | | 1 | | | | | | | | 1 |
NA12878.SLX sample bam Cave Zoom in to see coverage
NA12878.5LX sample.bam Zoom in to see alignments.

AU VA O | A 0O R OO RO

Gene
1L1 PGD PAX7 SFN GJB5 TIE1 GPX7 NFIA NEGR1 TTLL7 EVIS OLFM3 WNT2B ANKRD20A12P CDID MAEL TNR NPL RGS18 NAV1 NEK2 HHIPL2 KCNK1 AKT3
SNP Calls l ‘ ]
snpl snp3 snp2
5 tracks loaded hr1:144,403,123 136M of 602M




Viewing SNPs

Hands-on exercise

Navigate to first putative SNP locus

Type “snp1” in the Search Box and click Go

IGV
g % |




Viewing SNPs

Hands-on exercise

41 bp
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | |
[0-50)
WGS Alignments Coverage l
| |
I I
I I
v
iTi
iTi
iTi
[
iTi
i
iTi
i A
A iTi
i
WGS Alignments i
iEEi A
T iTi
i
i
iTi
iTi
iTi c
N
I I
I I
i
iTi
i
|
Sequence =(/[C T TCTTAT CC CGT CGAGTTT CCT CGS GAACGGAGAGTTAAGT CTCAG
RefSeq genes — K A L K G S R T G A
CLSTN1
|
SNP Calls
snp1
5 tracks loaded hr1:9,718,618 02M of 266M




Viewing SNPs

Hands-on exercise

4 bp
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | |
[0- 50]
WGS Alignments Coverage l
| |
i
P
I Sample = NA12878
; I : iRead group = ERR001757
i Read name = IL10_385:6:180:155:338
iTi ‘Location =chr1:9,718,629
i ‘Alignment start = 9,718,628 (-)
iTi Cigar = 36M
i Mapped = yes |
A | T | Mapping quality = 70
I D s
WGS Alignments i } Base = A
i T I ‘Base phred quality = 6
T L B
[ Pair start = chr1:9718480 (+)
Il Pair is mapped = yes
Il Insert size = -184
! Pair orientation = F2R1
TRl c
I
I I
.
| e
iTi =
i MF = 18
= RG = ERRO01757
— NM=1
Sequence ﬂCTTCTTATCCGCGAGTTTCCCGGAACUQ=4 C C A G
RefSeq genes Ag =25 G A
cistvt. e
|
SNP Calls
snp1
5 tracks loaded hr1:9,718,618 02M of 266M




Viewing SNPs

Hands-on exercise

To modify the info popup behavior:

Click yellow balloon icon in toolbar

—

For a larger data panel:
Click & drag the window divider

@ 0 =)

Sample = NA12878

Read group = ERR001757

q 12 qz 1.1 qz 3 1 Read name = IL10_385:6:180:155:338

Location = chr1:9,718,629
Alignment start = 9,718,628 (-)

Cigar = 36M
Mapped = yes
Mapping quality = 70

Base = A
Base phred quality = 6

Pair start = chr1:9718480 (+)
‘ Pair is mapped = yes

Insert size = -184

G ‘Pair orientation = F2R1

Firstin pair

(153 1 K T (U —
o s

RG = ERR001757
NM=1

uQ =4
Aq =25




Viewing SNPs

Hands-on exercise

Click & drag to

position mismatched ;
= | hases between the :

center guidelines




Viewing SNPs

Hands-on exercise

WGS Alignments ‘

9,718,610 bp

Copy read details to clipboard

|
} Rename Track...
|
|

\

IT
IT
IT

[0- 50]
WGS Alignments Coverage ‘ Group a|lgnment5 by > !
Sort alignments by > start location ‘
. Color alignments by > read strand

| ) first-of-pair strand |
'V Shade base by quality

‘\/ Show mismatched bases
. Show all bases

mapping quality

sample }
. . . read group

«| Right-click on alignments and select =——

Sort alignments by > base en gy (chromosome ofmaie |

I I - T =

On Mac: )ack alianments -

Right-click = Control-click i
Sequence -0|HCTTCTTATCCGCGAGTTTCC!C!GGAACGGAGAGTTAAGCCAG
RefSeq genes
SNP Calls L




Viewing SNPs

Hands-on exercise

M bp
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | |
[0- 50)
WGS Alignments Coverage .
Tl ©
T iTi
it
it
iTi
T
iTi
it
it
iTi
T
iTi
it
iTi
WGS Alignments Tl
T
iTi
i
i A
i
i
i
&
I I
I I
I I
I I
I I
B
Sequence =(I[C T TCTTA AT CCGC CGAGTTTZ CCZ CGGAACGGAGAGTTAAGT CTCASG
RefSeq gones K K D A L K G S R L T L G A
CLSTN1
|
SNP Calls
snp1
5 tracks loaded |[chr1:9,718,607 i |[237M of 266M




Viewing SNPs

Hands-on exercise

i; otal count: 43

9,718,610 bp ! ‘A :1(2%, 0+, 1-) ‘ bp BALLDED
' I'T|c:17 (40%, 10+, 7-) | ;
] [0-50] ! ‘G :0 ‘
WGS Alignments Coverage ! ‘T : 25 (58%’ 13+' 12_ ) ‘ l
'N:O }

o i e e e o e e o

H= =<

WGS Alignments

Mouse over red & blue bar in coverage track. | -
Note allele counts and frequencies.

Sequence =|[[C T TCTTATT CCGCGAGTTTU CCZC CGG GAACGGAGAGTTAAGTCTCAG
K [4 D A L [4 G S [ L T L G A
CLSTN1

RefSeq genes

SNP Calls
snp1
5 tracks loaded |[chr1:9,718,607 i |[237M of 266M




Viewing SNPs

Hands-on exercise

M bp
9,718,610 bp 9,718,620 bp 9,718,630 bp 9,718,640 bp
| | | | |
[0- 50)
WGS Alignments Coverage .
It ©
T iTi
iTi
it
iTi
T
iTi
it
it
iTi
T
iTi
it
iTi
WGS Alignments Tl
T
iTi
i
i A
i
i
i
&
I I
I I
I I
I I
I I
B
Sequence =(I[C T TCTTA AT CCGC CGAGTTTZ CCZ CGGAACGGAGAGTTAAGT CTCASG
RefSeq gones K K D A L K G S R L T L G A
CLSTN1
|
SNP Calls
snp1
5 tracks loaded |[chr1:9,718,607 i |[237M of 266M




Viewing SNPs

Hands-on exercise

Navigate to next putative SNP locus

Type “snp2” in the Search Box and click Go

IGV
N CEl




Viewing SNPs

Hands-on exercise

| |
: % of | lity b Il d
sz -wun | NOTE: Large % of low quality base calls, an
| |
o V24 Q
= scatter of “C” mismatches
WGS Alignments Coverage
| |
i
c ici
P
| |
i
[
P
c c © Ic!
P A
P
c ici
P
lel
WGS Alignments c | |
P c
P
I I
i
i
i
P C
| |
P
icl
P
| |
i
P
Sequence =/[|/|[A G T AT CGGGU GAGATG GACTACACAGCT CACTT CTGACCTCTA AGSGA
RefSeq genes E Y [ G D D Y T A T L T L G
TOMM40L
[ |
SNP Calls
snp2
5 tracks loaded hr1:159,464,343 33M of 376M




Viewing SNPs

Hands-on exercise

Click & drag to 3 i)
position locus with | “ |
5 blue C’s between c
center guidelines
eeeeee ce -0GTTCGGAGTGCTCAAGCATCGACCAGA




Viewing SNPs

Hands-on exercise

41 bp
159,464,340 bp 159,464,350 bp 159,464,360 bp
| |
[0-56]
WGS Alignments Coverage
| |
i n
c icl
i
i
i
i
i
Cc (o Cc : Cc :
(.
G ici
i
ici
WGS Alignments C | i
i
I I
| i
I I
| i

WGS Alignments

Rename Track...
Copy read details to clipboard

Group alignments by
Sort alignments by

|
|
|
|
|
|
|
|
} Color alignments by

v Shade base by quality

v Show mismatched bases
Show all bases

View as pairs

Go to mate

View mate region in split screen
Set insert size options ...

Shade base by quality

Right-click on alignments and deselect

Sequence -’
E Y R G D D Y T
TOMM40L

RefSeq genes

SNP Calls

snp2

A GTATU CGGGG GAGATG GACTACACAGC CT CACTT CTGACCT CTAGGA

A

T L T L G

5 tracks loaded hr1:159,464,343

'33M of 376M



Viewing SNPs

Hands-on exercise

41 bp
159,464,340 bp 159,464,350 bp 159,464,360 bp 159,464,370 bp 1
| | | |
10-58]
WGS Alignments Coverage
G G [
| |
G G A Cc C G Icl
I I
P
[ A A A A A A
A [
I
G A A A A ccec c el
[ A c
G 11
T Cc c cC Ic!
G AT G T ol
T G c cC el
WGS Alignments Cc C | |
iioc ¢
P
P
A A AlTlG
A [
P
G i G
P
P
ici
P
| |
i
|
Sequence =||/|[A G T ATCGGGGAGATU GATCTACACAGC CTCACTT CTS GATCCTCTAGTGA
ponan— E Y R G D D Y T A T L T L G
TOMM40L
|
SNP Calls
snp2
5 tracks loaded hr1:159,464,348 67M of 376M




Viewing SNPs

Hands-on exercise

. WGS Alignments

Rename Track...
Copy read details to clipboard

159,464,340 bp
|

Group alignments by
Sort alignments by
Color alignments by

[0-56]
WGS Alignments Coverage

v Shade base by quality
v Show mismatched bases
| Show all bases

View as pairs
. Go to mate

View mate region in split screen

WGS Alignments

Right-click on alignments and select
Sort alignments by > read strand

start location
read strand
first-of-pair strand \
base ‘
mapping quality }
sample |
read group }
\
\
\
|

insert size
chromosome of mate
tag

c

RefSeq genes
TOMM40L

|
SNP Calls

snp2

Sequence =|I/|[A G T ATCGGGGAGATU GATCTACACAGC CTCACTT CTS GACCTCTAGTGA
E Y R G D D Y T A T

T L G

5 tracks loaded hr1:159,464,343

33M of 376M




Viewing SNPs

Hands-on exercise

WGS Alignments

Rename Track...
Copy read details to clipboard

159,464,340 bp 159,46
|

Group alignments by
Sort alignments by
Color alignments by

[0-56)

WGS Alignments Coverage no color

insert size
pair orientation

v Shade base by quality

tag
bisulfite mode >

v S:ow rr|1llsbmatched bases v insert size and pair orientation
Show all bases read strand
View as pairs first-of-pair strand }
Go to mate read group \
View mate region in split screen sample }
T . |
\

WGS Alignments

Right-click on alignments and select

:
Color alignments by > read strand
m .
P
el
P
o
B
Sequence =(I[/[A G T AT CGGGGAGATS GAT CTACACAGTCT CACTT CTG GACCT CTAGSGA
RefSeq genes E Y R G D D Y T A T L T L G
TOMM40L
|
SNP Calls
snp2
5 tracks loaded hr1:159,464,343 33M of 376M




Viewing SNPs

Hands-on exercise

41bp
159,464,340 bp 159,464,350 bp 159,464,360 bp 159,464,370 bp 1
| | | |
-]
WGS Alignments Coverage
c = A © CHEGEIICH!
i A A A A A A
G A A A A c cc (] Icl
T c c C Icl
T = EECEIICE|
A A AlTlG
ici
G P
G G A [
G G [
i
i
i
i
'WGS Alignments | | A (o3
G i
G AT G T (|
i i ¢ c
i
i
G i G
i
i
A P
c c [
i
A i
[
P
Sequence =[[[AGTATCGGGGATGATGATCTACACAGCTC CACTCTGATCCTCTATZGGA
RefSeq genes E Y R G D ) Y T A T L T L G
TOMM40L
|
SNP Calls
snp2
5 tracks loaded |[chr1:159,464,376 Il |{236M of 376M




Viewing SNPs

Hands-on exercise

WGS Alignments Coverage

HEHE NS

Reset the color option:

'WGS Alignments

Right-click on alignments and select
Color alignments by >

insert size and pair orientation

Sequence

RefSeq genes

SNP Calls

A GTATU CGGGGAGATU GACTACACAGC CT CACTT CTGACCTCTAGSGA

T
TOMMA40L

snp2

5 tracks loaded | lchr1:159,464,376




Viewing SNPs

The NEW ENGLAND JOURNAL of MEDICINE
BRIEF REPORT
. . [
Exome Sequencing, ANGPTL3 Mutations, : L
and Familial Combined Hypolipidemia : lc1a
: P
Kiran Musunuru, M.D., Ph.D., M.P.H., James P. Pirruccello, B.S., Ron Do, M.S., . g la
Gina M. Peloso, M.S., Candace Guiducci, B.S., Carrie Sougnez, B.S., = : G : A
Kiran V. Garimella, M.S., Sheila Fisher, M.L.A., Justin Abreu, M.S., ; [
Andrew J. Barry, B.S., Tim Fennell, B.S., Eric Banks, Ph.D., Lauren Ambrogio, B.S., ) i
Kristian Cibulskis, B.S., Andrew Kernytsky, Ph.D., Elena Gonzalez, B.S., ) : :
Nicholas Rudzicz, M.S., James C. Engert, Ph.D., Mark A. DePristo, Ph.D., = i — i —~
Mark J. Daly, Ph.D., Jonathan C. Cohen, Ph.D., Helen H. Hobbs, M.D., iGia
David Altshuler, M.D., Ph.D., Gustav Schonfeld, M.D., Stacey B. Gabriel, Ph.D., : :
Pin Yue, Ph.D., and Sekar Kathiresan, M.D. i
: L
lgla
I
lcla
(B
lgla
P
(B
lgla
(B
lcta
[
[
o
[
[
(.
Icla
[Nl
[




Viewing SNPs

[ ) [ ) IGV
Human hg19 chrl B chr1:9,718,452-9,718,614 Go Tt <« » @ [ ® 2 | Eluniign
p36.23 p36.12 p35.1 p34l p322 p3l2 p22.3 p2l.3  pl3.3 pl2 qll ql2 q2L1 q22 q241 q252 Q311 q32.1 q32.3 q4211 q42.3 qdd
164 bp
9,718,500 bp 9,718,560 bp 9,718,600 bp

9,718,460 bp
|

9,718,480 bp
|

9,718,520 bp
|

9,718,540 bp
| |

9,718,580 bp
|

NA12878.SLX.sample.bam Cove|

NA12878.SLX.sample.bam

Sequence -

RefSeq Genes

SNP Calls

PIK3CD

15 tracks loaded

[145M of 579M




BED file used to define “bookmarks” in SNP exercise

snp_calls.bed

track name=“SNP Calls”
1 9718624 9718625 snpl
1 159464357 159464358 snp2

1 63650225 63650226 snp3



igvtools



A set of utilities for preparing large files for efficient display.

— Computes alignment coverage from BAM files

count’| _ b duces TDF or WIG files

— Converts sorted data file to binary tiled data (TDF)
toTDF | _ Supported file formats: WIG, bedGraph

— Sorts file by genomic start position.
sort

- Supported file formats: BED, GFF, GTF, PSL, SAM, BAM, VCF

- Creates index for large genomic annotation files and alignments.
Index | _ ,nnorted file formats: BED, GFF, GTF, PSL, SAM, BAM, VCF




igvtools: count

count

transforms alignment files to

read coverage files in TDF or WIG format.

Alignments
(BAM format)

)

-

-

igvtools

~

/

m==) Read coverage

*&L
i-....u“m .n“
&LM



Coverage track

Coverage track visible before alignments

(S NeNG) IGV

("Human hg18 [ chrl 18] o2 Go Bt « » m o= = =] e |
p3W23 p36.12 p343 p33 p321 p31.1  p22.2 p21.1  pl13.1 ql2 q21.1 q23.2 q243 q253 q31.3 q32.2 q42.11 q43
- 246 mb -
nb mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb

NA19240 SLX (YRI daughter) Co| 4©"%

age

NA19240 SLX (YRI daughter) < Zoom in to see alignments. ’

RefSeq genes R RO DU U R RO | L RO R SR S IOV I O O

8269 KAZN SYF2 SFPQ STIL CBA AK4 CRYZ UOX DR1 RNPC3 NRAS NR_033189 IFI16 XCL2 ABL2 FAMSC PKP1 RD3 HHIPLZ RBM34 NLR

4 tracks loaded [{chr1:95,509,957 [| |[185M of 266M




Coverage track

In our hands-on exercise:
Coverage track was not visible before alignments

nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb 200 mb 220 mb 240 mb

NA12878.5LX.sample . bam

Zoom ir

Gene U P AR O R O 1 R O OB AN {0 T (AU | N O R ORI
1L1 PGD PAX7 SFN GJBS TIE1 GPX7 NFIA NEGR1 TTLL7 EVIS OLFM3 WNT2B ANKRD20A12P CD1D MAEL TNR NPL RGS18 NAV1 NEK2 HHIPL2 KCNK1 AKT3
SNP Calls ‘ l l
snp1 snp3 snp2

5 tracks loaded hr1:144 403,123 136M of 602M



igvtools

Count 3
Input Fil, Browse
Output Fil
Genom:

(A) Launch from the IGV menu == = = o=

Medi
2% 10% ) 90% 98%
robe to Loci Mapping
Window Size 25
L]
Tools > Run IthOO'S
" EnR
Temp Directory
Max Records
| Close | Run

O r Messages

(B) Run from the command line

[GM31D-693:~] jrobinso%

[GM31D-693:~] jrobinso¥% i1gvtools count NALZ2878.bam NALZ2873.bam. tdf hgls



Pre-compute coverage track

Hands-on exercise

« Use igvtools to compute the coverage for a .bam file
« Associate the new file with the coverage track

[ Follow along ]




Coverage track

Hands-on exercise

Click on the left-most tick on the _—— E.||||||||||||||||||||I|

zoom ruler to zoom all the way out

- 246 mb
nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb

NA12878.5LX . sample.bam Cove Zoom in to see coverage.

NA12B78.5LX . sample.bam Zoom in to see alu.‘;r'n"'ler'l'.z.




Pre-compute coverage track

Hands-on exercise

Click Tools > Run igvtools

GenomeSpace Hel
Run Batch Script... {

Run igvtools...

Find Motif...
BLAT ...
Combine Data Tracks ﬁ

Gitools Heatmaps > |
BEDTools >




Pre-compute coverage track

Hands-on exercise

Click Tools > Run igvtools

EEISIIE RSCoRiC) Select the Count command

—g‘”‘ e | from the dropdown menu
\

Find Motif...

BLAT ... [ Input File Browse

a L
Combine Data Tracks | Output File Browse

Genome /Users /helga/Documents/IGVMarch2017/Exercises/genome/chrl.fasta Browse

GitOOIS Heatmaps > ‘ TDF and Count options
BEDTools > | Zoom Levels 7 B

Window Functions Min Max Mean Median
2% 10% 90% 98%

Probe to Loci Mapping Browse
Window Size 25
Extension Factor
Count as Pairs
Sort Options
Temp Directory Browse

Max Records 500000

Close Run

Messages




Pre-compute coverage track

Hands-on exercise

1. Input file: Browse to the Data / snps_morning folder and select the .bam file

Command Count u

/Users/helga/IGVMarch2017/Exercises/snps/NA12878.SLX.sample.bam

e)/Users /helga/IGVMarch2017/Exercises/snps/NA12878.SLX.sample.bam.tdf Browse

: Browse
2. Output file: Defaults to same folder, and same name + .tdf suffix
Zoom Levels 7 E
Window Functions Min Max Mean Median
2% 10% 90% 98%
Probe to Loci Mapping Browse
Window Size 25

Extension Factor

Count as Pairs

3. Other values: Keep defaults

Temp Directory Browse

close 4. Click Run

Sort Options

Max Records 500000

Messages

5. Close window after you see “Done” in the Messages area




Coverage track

Hands-on exercise

1. Right-click any where

on the coverage track ...

L] 20 mb JFmD 60 mb 80 mb
( | | | | | | | |
MNA12BTE.SLX . samiple.bam Cove

MA12BTE. SLX sample.bam

NA12878.SLX.sample.bam Coverage

2. ... and select Load pre-computed
coverage data from the popup menu

Set Data Range...
Log scale

v Autoscale

v/ Show Data Range

Set allele frequency threshold...

< Load pre-computed coverage data... >

Copy Details to Clipboard

v/ Show Alignment Track
Show Splice Junction Track
Hide Track

Save image...
Export track names...

Zoom in to see alignments.

3. Browse to the

Data / snps_morning folder
and select the file
NA12878.SLX.sample.bam.tdf




Coverage track

Hands-on exercise

A

nb

20 mb

40 mb

60 mb

80 mb

100 mb

246 mb

120 mb

140 mb

160 mb

180 mb

NA12878.SLX.sample.bam Cove




Coverage track

Hands-on exercise

-t 246 mb
nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb
| | | | | | I | | | | | | | | | | | |
[0 486]
NA1 N OW m Cove
N —
- 246 mb
nb 20 mb 40 mb 60 mb 80 mb 100 mb 120 mb 140 mb 160 mb 180 mb

NA WaS hm Cove Zoom in to see coverage.




Viewing RNA-seq Data



RNA-seq

pre-mRNA
Exon

MRNA

Short read is split by
intron when aligning

to reference Genome -_‘_‘_‘:;J

http://en.wikipedia.org/wiki/RNA-Seq#Gene_expression



RNA-seq

pre-mRNA

Exon

IGV

MRNA

Short read is split by :
intron when aligning : -

to reference Genome "R ;J

T~



RNA-seq alignments

800 IGV
File View Tracks Help
[ Human hg18 #) [chn [#]) [chr1:153,432,493-153,438226 | Go Ff « | » (@ [ = (= AN NANARAAT] [NANHA
|
(L I LT T T ] o o T T T [y [ T— I E—
p36.23 p36.12 p351 p3al p322 p3l.2 p223 p21.3 pi33 pl2 q12 q21.1 q22 q241 q25.2 q3L1
w ] 5,724 bp p g
= > " ] "
w 153,433,000 bp 153,434,000 bp 153,435,000 bp 153,436,000 bp 153437,00 I t
goal | ! I I | ! | I Sp ICe JunC [e]g]

accepted_hits.sorted.b [0~ 50) m
am Coverage

accepted_hits.sorted.b
am

THES3

RefSeq genes

chrl:153,436,452 i} 631M of 762M |
ST ———"




RNA-seq alignments

[ Splice junction track }

s .



RNA-seq alignments

[ Splice junction track }

Arcs represent reads that
span exon junctions




RNA-seq alignments

[ Splice junction track }

Height is proportional
to number of reads

s .



RNA-seq alignments

[ Splice junction track }

Many reads connecting
these exons




RNA-seq alignments

[ Splice junction track }

s .

Relatively few
spanning to this exon




RNA-seq alignments

~ Sashimi Plot

Elviereeerrrrrrifeeeernn =]

[0- 11850) 5844 heart
\f“ Y/Q ﬁ r ZSQOWIS\

100 ’A@G __—-—/_ 53 _\2749/ 7012

0- 5313
1_5 4
Pl A x

232 726

L 1 1 J
98986020 98989732 98993445 98997158

- L - L L -
—- L - L L -
— L - - - -




RNA-seq alignments

~ Sashimi Plot

e O O

E]|||||||||1|||||||||||||-

e —
_——-—/— 53

b SN S S——

Arcs represent

reads that span .
exon junctions —d W W N
232 3 — 26 - Noa e0s - -

L 1 1 J
98986020 98989732 98993445 98997158
- - -— — -— -

[ - -— -— -— .

I - _— _— _— N




RNA-seq alignments

~ Sashimi Plot

ioo " ||||||S|8IIII-
!r"" rzsgo. | ”I \

2

Numbers are

| read counts ﬂ/’ﬂl i
,"_,\“ . __\r 18 \*

L 1 1 J
98986020 98989732 98993445 98997158
- - -— — -— -

[ - -— -— -— .

I - _— _— _— N




RNA-seq alignments

~ Sashimi Plot

e O O
S ERIRRRREARNANE! NARNAREN

W e —
Peaks represent v
coverage within exon \rﬂ/_ﬂl\

‘\k —er&—‘ _4__27 = _\945./2(303 N - o




Sashimi plot

Viewing RNA splicing with Sashimi Plots

Reference:

Katz et al.

Quantitative visualization of alternative exon expression
from RNA-seq data

Bioinformatics (2015)



Viewing RNA-seq data

Hands-on exercise

Examine tissue-specific alternative splicing.

Data: lllumina BodyMap 2.0

[ See handout ]




Select View > Preferences...

N

® IGV23 File Genomes WUEUN Tracks Regions Tools

©00

[Human hgl9 :J | All

1 v Show Header Panel

Reorder Panels...

GenomeSpace Help
IGV
Color Legends ...
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Click Alignments tab

Gene

» T e

Proxy  lon Torrent

On initial load show: Alignment Track Coverage Track Splice Junction Track

Alignment Track Options

Visibility range threshold (kb): 30
Downsample reads Max read count: 100
Shade mismatched bases by quality: 5

Flag insertions larger than: 1 bases
Mapping quality threshold: 0

Hidden SAM tags: MD,SA

Filter duplicate reads
Filter vendor failed reads
Filter secondary alignments

Filter supplementary alignments

Range at which alignments become visible

per window size (bases): 50

to 20

| Flag unmapped pairs
Show soft-clipped bases

Show center line

Advanced

Coverage Track Options

Coverage allele-fraction threshold: 0.2

Splice Junction Track Options

Show flanking regions Min flanking width: 0

Quality weight allele fraction

Min junction coverage: 1

Insert Size Options

Defaults Minimum (bp): 50

Maximum (bp): 1000

Compute Minimum (percentile): 0.5

Maximum (percentile): 99.5

OK

Cancel
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98,996 kb

|[184M of 5970

|2 tracks loaded hr12:98,986,192




Human (hg19)

Gene

General  Tracks  Variants

Track Display Options

Charts Probes

Proxy  lon Torrent

On initial load show: Alignment Track Coverage Trik plice Junction Track

Alignment Track Options

Visibility range threshold (kb): 30

Downsample reads Max read count: 100

Shade mismatched bases by quality: 5
Flag insertions larger than: 1 bases

Mapping quality threshold: 0

Hidden SAM tags: MD,SA

Filter duplicate reads
Filter vendor failed reads
Filter secondary alignments

Filter supplementary alignments

Range at which alignments become visibl.

per window size (bases): 50

to 20

Advanced

‘ Sl g =+

3 q2412

q24.23

q24.32

98,996 kb

Select Splice Junction Track

Flag unmapped pairs
Show soft-clipped bases

Show center line

Coverage Track Options

Coverage allele-fraction threshold: 0.2

Splice Junction Track Options

Show flanking regions Min flanking width: 0

Quality weight allele fraction

Min junction coverage: 1

Insert Size Options

Defaults Minimum (bp): 50

Maximum (bp): 1000

Compute Minimum (percentile): 0.5

Maximum (percentile): 99.5

OK

Cancel

|2 tracks loaded hr12:98,986,192

|[184M of 5970




Human (hg19)

Gene

General  Tracks  Variants  Charts

Probes Proxy  lon Torrent
Track Display Options

On initial load show: Alignment Track Coverage Track Splice Junction Track

Visibility range threshold (kb): 30 Range at which alignments become visible
ownsample reads Max read count: per window size (bases):
Shade mismatched bases by quality: 5 to 20
Flag insertions larger than: 1 bases

Mapping quality threshold: 0

Hidden SAM tags: MD,SA

Filter duplicate reads | Flag unmapped pairs

Filter vendor failed reads Show soft-clipped bases
Filter secondary alignments Show center line

| Filter supplementary alignments

Advanced

Coverage Track Options

Coverage allele-fraction threshold: 0.2 Quality weight allele fraction

Splice Junction Track Options

Show flanking regions Min flanking width: 0 Min junction coverage: 1

Insert Size Options

Defaults Minimum (bp): 50

Maximum (bp): 1000

Compute Minimum (percentile): 0.5

Maximum (percentile): 99.5

OK

Cancel
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3 G412 2423 q2432
98,996 kb
|
—
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|2 tracks loaded hr12:98,986,192




Human (hg19) < ch

Click

Gene

|2 tracks loaded hr12:98,986,192

General  Tracks Variants  Charts Probes  Proxy lon Torrent  Advanced
Track Display Options
On initial load show: Alignment Track Coverage Track Splice Junction Track
Alignment Track Options
Visibility range threshold (kb): 30 Range at which alignments become visible
Downsample reads Max read count: 100 per window size (bases): 50
Shade mismatched bases by quality: 5 to 20
Flag insertions larger than: 1 bases
Mapping quality threshold: 0
Hidden SAM tags: MD,SA
Filter duplicate reads Flag unmapped pairs
Filter vendor failed reads Show soft-clipped bases
Filter secondary alignments Show center line
Filter supplementary alignments
Coverage Track Options
Coverage allele-fraction threshold: 0.2 Quality weight allele fraction
Splice Junction Track Options
Show flanking regions Min flanking width: 0 Min junction coverage: 1
OK to save changes g v os
Maximum (bp). 1000 Maxi (percentile): 99.5
OK Cancel
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3 q2412

q24.23

q24.32
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|[184M of 5970




* Click File > Open Session

&€ IGV 2.3.82

0@
Human hgl9

ZIEW Genomes View Tre

Load from File...
Load from URL...
Load from Server...
Load from DAS...
Load from ENCODE...
Load from Ga4gh...

~

Save Image ...

Exit
I

* Navigate to the workshop data folder,
and select rna / rna_session.xml

| NON ) = Exercises
< 23 D ol g8 v v |
Back %w Arrange Aﬁion Sl[ire Edit Tags .
Name ~  Date Modified Si
v [ lrna Sep 26, 2016, 6:47 PM
chr12.fa Mar 20, 2009, 12:01 PM 136.5 M
chri2.fa.fai Aug 31, 2016, 7:25 PM 24 byt
heart_slc25a3.bam Aug 31, 2016, 6:57 PM 318 K
heart_slc....bam.bai Aug 31, 2016, 6:57 PM 49 K
hg19_chr12.genome Aug 31, 2016, 7:25 PM 177 K
liver_slc25a3.bam Aug 31, 2016, 6:58 PM 257 H
liver_slc...3.bam.bai Aug 31, 2016, 6:58 PM 49 H
é B rna_session.xml Sep 26, 2016, 6:23 PM 314 byt
» =] snps Sep 26, 2016, 6:47 PM
> [ svs Sep 26, 2016, 6:47 PM
> vcf Sep 26, 2016, 6:47 PM

& MacintoshHD » (&1L » & b » (@[> [2F» rna » rna_session.xml

1 of 12 selected, 14.5 GB available
.
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[ JoN J IGV - Session: /Users/jrobinson/Google Drive/ASHG/Exercises/rna/rna_session.xml

Human (hg19) B 2 B} chr12:98,985,403-98,997,778 Col Bt « » @[ = A | Sl =

98,986 kb 98,988 kb 98,990 kb 98,992 kb 98,994 kb 98,996 kb

[0-319)
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Viewing RNA-seq data

Hands-on exercise

[ JoN J IGV - Session: /Users/jrobinson/Google Drive/ASHG/Exercises/rna/rna_session.xml

Human (hg19) B 2 B} chr12:98,985,403-98,997,778 Col Bt « » @[ = A | Sl =

12 kb
98,986 kb 98,988 kb 98,990 kb 98,992 kb 98,994 kb 98,996 kb
| | | | | |
=
Coverage [
| | i
¥ i
fiver_sk25a3 bam Junctions — 1 e} LA —
5 1
liver_sk25a3 bam
1 [
S |

[0-554]
heart_sk25a3.bam Coverage
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Viewing RNA-seq data
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[ JoN J IGV - Session: /Users/jrobinson/Google Drive/ASHG/Exercises/rna/rna_session.xml

Human (hg19) B 2 B} chr12:98,985,403-98,997,778 Col Bt « » @[ = A | Sl =

Junction Coverage |__"= i e o

iver_skc25a3.bam Coverage

fiver_sic25a3.bam Junct]

iver_skc25a3.bam

[0-554]
heart_sk25a3.bam Coverage
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Viewing RNA-seq data

Hands-on exercise

[ ] [ ] IGV - Session: /Users/jrobinson/Google Drive/ASHG/Exercises/rna/rna_session.xml

Human (hg19) B 2 B} chr12:98,985,403-98,997,778 Go FX < » @ [ = 2 | S =

98,986 kb 98,988 kb 98,990 kb 98,992 kb 98,994 kb 98,996 kb

[0-319)
liver_sk25a3.bam Coverage

3 g - | |
Q‘H u ‘/-\‘“m‘\“ \
liver_sic25a3.bam Junctions - B c— —F =1 g >g{gﬁ171

iver_skc25a3.bam

Right'CIiCk over ng 1 .m’ ' 'I‘(meﬁr\m[’ ‘ N '
Genes track . - - -

heart_skc25a3.bam

- ——a = JHil—

SLC25A3 SNORAS3

Gene

[8 tracks loaded |[enr12:98 985,608 I |[198M of 5370




Viewing RNA-seq data
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[ ] [ ] IGV - Session: /Users/jrobinson/Google Drive/ASHG/Exercises/rna/rna_session.xml|
Human (hg19) B o B chr12:98,985,403-98,997,778  Go Y < » @ [ = 2 | S =

p1332 p13.2  pl23 pl21 pIL21 ql1 q12 ql13.11 q13.2 qi42  qi5 q21.2 q21.31 q21.33 q23. q233 q24.12 q24.23 q2432

98,986 kb 98,988 kb 98,990 kb 98,992 kb 98,994 kb 98,996 kb
|

[0- 319
livar_sic25a3.bam Coverage

@l | : U - gy h‘\f—\ \
liver_skc25a3 bam Junctions @“‘J’" 5—— — V[-\‘\‘.‘\ H‘ ~ ~ - V - :’fﬂ - =

iiver_sk25a3.bam

10- 554
heart_sk25a3.bam Coverage

Select Squished Bl — | | | = |
from the popup — e 3 1B

menu to display
isoforms in the
Gene annotation
track

|
|
|
|
|
|
|
|
I
I
|
|

IB tracks hr12:98,987,004 7M of 537M
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[ [ ] IGV - Session: /Users/jrobinson/Google Drive/ASHG/Exercises/rna/rna_session.xml|
Human (hg19) B o B chr12:98,987,187-98,990,000 Go Y <« » @& [ = 2 | S =

2,809 bp
98,988,000 bp 98,989,000 bp 98,990
|

livar_sic25a3.bam Coverage

- A=l A v
liver_sk25a3 bam Junctions i — -

| Evidence of
alternative
E— splicing ‘

hear_skc2Sa3bam duncions ||| e —— =

heart_sk25a3.bam

Gene

B tracks




N ||
p1332  pl3.2

p12.3

pl2l

oo
pii2l qil

qi2 ||

liver_slc25a3.bam

Right-click and
select Sashimi Plot

Sashimi Plot

. v Show Coverage Track
v/ Show Splice Junction Track
Hide Track

| Save image...
Export Alignments...

Rename Track... I E i 4
Copy read details to clipboard I I —
1 s B s T
A q21.33 q23.1 q233 q24.12 q24.23 q24.32
Group alignments by >
Sort alignments by >
Color alignments by > 8,994 ke 996 kb
Re-pack alignments ! ‘ ' ‘
./ Shade base by quality E
v Show mismatched bases
Show all bases
| View as pairs | - —_—
| Go to mate I
View mate region in split screen
Setinsert size options ... Tl
| Collapsed I
. Expanded
- Squished
Select by name... I
Clear selections i
sequence I
Blat read sequence ]
Copy consensus sequence )
3|

Export track names...

Remove Track




Human (hg19 chrl chr12:98,985,40 )9 Ge » @ [ = oo =
e — | - I [ B B B BN Eme Wi W T
p13.32  pl3.2 pl23  pl2l pIi2l qi1  ql2 qi3iil q13.2 qid.2 qis q2i2 q21.31 q21.33 q23.1 G233 q2ai2  q24.23 q24.32

12 kb
8.9 9 88 k 98,990 kb 98,992 kb 8,994 kb 996 kb
| | | | | |

@ @ Select Alignment Tracks

liver_slc25a3.bam — ——

& heart_slc25a3.bam

lected and click OK
OK Cancel
- - + i - - . -
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Viewing RNA-seq data
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Launch Sashimi Plot
from the popup menu

=R (e,
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Viewing RNA-seq data

Hands-on exercise

Filter and zoom in

Junction Coverage Display

Set Junction Coverage Min

Set Color
v Show Exon Coverage Data

v Text
Circle
None

. v Combine Strands
Forward Strand
Reverse Strand —

Save Image...

et Junction Coverage Min = 50




Viewing RNA-seq data

Hands-on exercise

Filter and zoom in on

the first few exons =R e
(0- 472) 2836 heart
_J L v L l
_%/Il 136
4 J _ o R l o
Kzsz/—\ 726 — T
9898I7397 9898I8239 9898I9081 9898I9923




Viewing Structural Events



Structural events

e Structural events include deletions, duplications, translocations,
and inversions.

* Paired reads can yield evidence of structural events.

* Alignment coloring options help highlight these events based on:

* Inferred insert size (template length)

* Pair orientation (relative strand of pair)



Paired-end sequencing

DNA or W
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Paired-end sequencing

DNA or W

cDNA
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Paired-end sequencing

DNA or W

cDNA

fragment ~ -~ ~~ N\ —
read from ——> e e AN
each end - - aa

cign b0 —
reference - < — <
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Paired-end sequencing

cDNA

fragment ~ -~ ~~ N\ —
read from ——> —t =

e = =
insert size (or template length)

align to
reference - < — <

inferred insert size (or observed template length)




Interpreting inferred insert size

Differences between insert size and inferred insert size*
can be used to detect evidence of structural variants,
including

e Deletions
* |nsertions

* Inter-chromosomal rearrangements

* or template length and observed template length



Interpreting inferred insert size

Differences between insert size and inferred insert size*
can be used to detect evidence of structural variants,
including

. {Deletions }

* |nsertions

* {Inter-chromosomal rearrangements }

* or template length and observed template length
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Inferred insert size

reference m
genome

— -

Expected insert size

subject &

Inferred insert size is greater than expected value




‘ Pairs with larger than expected insert size are colored red ‘
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Deletion

Pairs with larger than expected insert size are colored red
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Deletion

Note drop in coverage
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Inter-chromosomal fusion
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Inter-chromosomal fusion
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Inter-chromosomal fusion
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Inter-chromosomal fusion
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Inter-chromosomal fusion

reference chrl chré
genome — _
chr 6 color chr 1 color

‘ Each read is colored by the chromosome of its mate ‘

Chromosome colors:
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Inter-chromosomal fusion
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Insert size color scheme

* Smaller than expected insert size: —
* Larger than expected insert size: =

* Pairs on different chromosomes:

Each end colored by chromosome of its mate

ElTTEE B =N EEEE e
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 19 20 21 22 X Y



Interpreting pair orientations

Orientation of paired reads can reveal
evidence of structural events, including:

* Inversions
 Duplications

 Translocations



Interpreting pair orientations

Orientation of paired reads can reveal
evidence of structural events, including:

» Inversions |

 Duplications

 Translocations
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Inversion
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Inversion
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Viewing structural events

Hands-on exercise

« Use color and viewing options to examine an inversion

« Data from 1000 Genomes

[Followalong ]




Viewing structural events

Hands-on exercise

Click File > Open Session

.’ IGV_2.3.82 BFIE® Genomes View Tre

[ NN Load from File...
" Load from URL...
Load from Server...
Load from DAS...
Load from ENCODE...
Load from Ga4gh...

-~

Human hgl9

Save Image ...

Exit
Il

Navigate to the folder IGV workshop folder / Data / svs
and select file svs_session.xml




Viewing structural events

Hands-on exercise
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Viewing structural events

Hands-on exercise

Right-click on the alignments and select
Color alignments by > pair orientation

TNCTTarTTC TTack..:

Copy read details to clipboard

Croup alignments by >

Sort alignments by >

Color alignments by » no color

Re-pack alignments v insert size

.

v Shade base by quality insert size and pair orientation
v Show mismatched bases read strand

Show all bases first-of-pair strand

View as pairs read group

A sample

C(ﬁl (0 mate o

. L T library

view mate region In split screen

Setinsert size options tag

P bisulfite mode >

Collapsed |
v Expanded

Squished

Select by name...
Clear selections

Copy read sequence
Blat read sequence
CODY consensus sequence

Sashimi Plot

v Show Coverage Track
Show Splice Junction Track
Hide Track

Save image...
Export Alignments...
Export track names...

Remove Track



Viewing structural events
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Viewing structural events

Hands-on exercise

Right-click on the alignments and select
View as pairs

Copy read details to clipboard

Group alignments by >
Sort alignments by >
Color alignments by >

Re-pack alignments

v Shade base by quality
v Show mismatched bases
Show all bases

Co to mate

View mate region in split screen
Setinsert size options ...

Collapsed
v Expanded
Squished

Select by name...
Clear selections

| Copyread sequence
Blat read sequence
Copy consensus sequence

Sashimi Plot

v Show Coverage Track
Show Splice Junction Track
Hide Track

Save image...
Export Alignments...
Export track names...

Remove Track




Viewing structural events

Hands-on exercise

Human (hg38 chr21) +| | chr2l :| chr21:26,000,000-26,004,000 Go TF « » @ [ = 2 | S =
I I Jme-—catl L | | T
pl13 pl2 pl1.2 pll.l ql1.2 q21.1 q21.2 q21.3 q22.11 q22.12 q22.2 q22.3
3,993 bp
000 bp 26,001,000 bp 26,002,000 bp 26,003,000 bp 26,004
| | | | | | |
0- 14
NA19240.bam Coverage
| . . l - |
|2 + - | | \
I - e !
J I -n-—a.
! - aE [
. am-—a |
I = | !
-» e
NA19240.bam - -
i [
i
i
|
Gone B < e o B B T o S S o T e S e o S I
APP
14 tracks loaded Ehl’21:26.001.019 EBSM of 1,047M



Viewing Structural Events



Availability

Features available in IGV 3.0 Beta

See Other Versions on the IGV Downloads page



Third Gen Sequencing

* Long reads:
~10,000 bp up to ~100,00 bp

* High raw error rate in individual reads
(high consensus accuracy with sufficient coverage)

* Platforms:
— PacBio, Oxford Nanopore



IGV Enhancements

* Filtering raw errors to reveal consensus variants

* Extended support for split alignments
* Linking split reads
e Support for “SA” tag



Filtering raw errors — small indels

chr10
CH N T N . >~
pi5.1 pi3 pI2.2 pli.23 plll qll.22  q2l1.1 q21.3 q22.2 q23.1  q23.32 q242 q251 q253 Q2613 q26.3
-+ 10 kb -
,000 bp 128,032,000 bp 128,033,000 bp 128,034,000 bp 128,035,000 bp 128,036,000 bp 128,037,000 bp 128,038,000 bp 128,039,000 bp 128,040,000 bp 128,04
I | | | | | | | | | | | | | | | | | | |
0137
PacBio
RIRRN | ]
mi
CLEEI T ] i |1

Aaron Wenger, PacBio




Filtering raw errors - indels

chr10

N pi3 pI2.2 pli23  plll  qll22  q21.1 a21.3  q222  q23.1  q2332 q242 q251 253 q2613 @ q263

10 kb

000bp 128,032,000 bp 128,033,000 bp 128,034,000 bp  128,035000bp 128,036,000 bp 128,037,000 bp 128,038,000 bp 128,039,000 bp 128,040,000 bp 128,04
| | | | | | | | | | | | | | | | | | | |

i [em
Small indels filtered
from view

PACBIO

L | Nl

0- 108)

CLEEI T ] i |1

ILLUMINA

Aaron Wenger, PacBio




Filtering raw errors - nucleotides

PACBI

ILLUMI

chr10

p15.1 pi3 pl2.2 pil23 plldl  qll.22  q21.1 q21.3  q222  q23.1 q2332 q242 q251 q253 Q2613 Q263
- 10 kb >
000bp 128,032,000 bp  128,033,000bp 128,034,000 bp  128,035000bp 128,036,000 bp  128,037,000bp 128,038,000 bp  128,039,000bp 128,040,000 bp  128,04'
| | | | | | | | | | | | | | | | | | |

PacBio

o

[0-137)

ANy i | ]

LTI 111 [ 1 Y I IIIIIIIIII Il IIIIIIII L1 T N L T MU IR lIII Il IIIIII IIIIIII
Il IIIIIII IIIIIII]]IIIIIIII IIIIIIII IIIII IIII L L T T 11 A A AT 1A
NN LNl IIIIIIIIIIII LR (1T IR T AT IIII 00 1 A A TN IIIIII 1
L1 II III IIII L 1 1 1 1 1t 10 1 1 0 1 AT AY AN
LA RRTTONTTRTRY LY TATUTTE WERRTYTON T WACN RO T RARARCR YRR 4T 1 W IIIIIIIIIIIIII (A Wil IIIlIIIIIII TR
LT IAD T T AR R AT VLA A N 1 L 11 e W B
JAIRNTI i II LT T N TV Y SRR TRN IIIIIIII 1L IIII IIlI LU RLAROTTR T LU RV I I II L AT T T

[ N A IIIIIIIIIIIIIIIIIIIIII {100 T W 1 11 e TN I
[ AL Il I ¥ T RN TREEETE e e IIIIII IIIIIIIIIIIIIIIIIIllIIIIlIIIIIIII (LN I AR
I T | III [ L A | I L 11/ 1 AR N A

T IIIIIIIIIIIIII [

| LT
(AL A TS AT IIIIIIIIIIIIII

111/
IIIIIIIII IIIIII Il

I LA 1 A VYRR (T IIIIIII (011 1 A A T
Il (0 4 1 1 | IIIIIII IIII 1N IIII I 1 1
I

| |
LU TR Tt IIIIIIII [T I IIIII IIIIIII IIIIIII el IIIIIIIIIIIIII II [ Il IIIII IIIIIIIIIIIIII (RN
0 AT KT T I [ Ll I II 111 B ANV TR [
TN IIIIIIIIIIIII III IIIIIII IIIIIII (I} II II IIIIIIIII IIIIIIIIII IIIIII IIIIIIIIIIIII IIIIIIIIIIIIII IIIIII III (1w III III I Il IIII | T III I I I III
10NN T T 1 LI 00 A T 1L LA [ [
IIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIIII-IIIIIIIIIIII-IIIIIIIIII[ Il III IIIIIIIIIII | IIIIII IIIIIIIIIII IIIIIIIIIIIIIII [ IIIII I I IIIIIIII IIIIIII IIIIIIIIII LI T A T II IIIIII IIIIIIIII
10 I | [ NN Y 1/ 1A LT (O A AT L

II IIIII IIl LA 1 0T W T IIIIIIIIIIII Q10 O e W IIIIIIIII O 0 e

[0- 108)

Ilumina
c R D o I 1
DuEE NN I pEEE Tt
| 01 U 1 T WS R PSR
mn i ] | I RN T L
| WU 0 8 5 | I 11 11 0 O 0 V0
o ! = e | 1 T 01 " 18 8 A O
NA [l | 110 B 0 A 9 9 o e | | T
T R {008 ) I A 5 0 I L | i
50 0 0 0 0 | T I I il S
T | ] ! i i) T I
I VD T R L I 1 S A | L
e = T n 1 9 S W W | TR B
| A1 | i N | )| I S Ew 000 SR
) 0 I 1T 0 11T
TITIXITTITIITITITIT O i AR
T I I TIILIT 10 O TN
i T 18 I O | 155 S R S
| T | S | R R
LU oy 1 Il I (I | { | il 1l Il |

Aaron Wenger, PacBio




Filtering raw errors - nucleotides

chr10
p15.1 p13 p12.2 pl1.23 plll q11.22 q21.1 q21.3 q22.2 q23.1 q23.32 q24.2 q25.1 q25.3 q26.13 " q26.3
- 10 kb -
,000 bp 128,032,000 bp 128,033,000 bp 128,034,000 bp 128,035,000 bp 128,036,000 bp 128,037,000 bp 128,038,000 bp 128,039,000 bp 128,040,000 bp 128,04°
| | | | | | | | | | | | | | | | | | |
T ] ‘[o 137)
TR B ]
| | I
o H k 144 d | | [
Quick consensus” mode RNRTIRAT | =
T | LI B I | |
| | |
| | |
| [ B B | I A RN | I
PACBIO w E
| | I
| I A | I
| [ A I |
| I I | B | |
| I
| | | |
| | I B | | |
| | |
|
0- 108)
! WARN W . ( |1
FERE S | | 151
| {1 | 151
I 1 | I
| | Il | | e
| q. | | RN
ILLUMINA RSN AN AN N i |
| I IR | [op
RS I I 1 | |
| | | | |
I 1111 | |
| e I | |
| FER | | 191
| |5 | | | |
| BEaE | Il
| [ I (| | |
181 1111 | | 1HEI
| i |
] 1L | | i) ]

Aaron Wenger, PacBio
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11kb
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.
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Deletion clearly visible
in the long reads

08

LINE:L1

SINE:AlY

SINE:MIR

T_rich

mplexity:A

SINE:MIR3 Simple_repeat:(CAJn LINE:L1HS Low_co

DNA:MERSA1

‘MER45A

LTR:THE1C

LINE:L1HS

Aaron Wenger, PacBio




View > Preferences
Alignments tab

Purple insertion labels

General Tracks  Variants  Chart

;

pbes  Proxy lonTorrent  Advanced

Track Display Options

Alignment Track Options

Visibility range threshold (kb): 500
Downsample reads Max read count: 2000
Shade mismatched bases by quality: 5
Mapping quality threshold: 20

Label indels > 5 bases

Hide small indels

mismatches

Only show consistent

Hide indels < 50 bases

Hide indels < 1 pixels

Filter duplicate reads
Filter vendor failed reads
Filter secondary alignments

Show center line

On initial load show: Alignment Track Coverage Track

| Splice Junction Track

Range at which alignments become visible
per window size (bases): 50

to 20

Flag unmapped pairs
Show soft-clipped bases
a Quick consensus mode

Filter supplementary alignments

en SAM tags: MD,SAXA

overage Track Options

Coverage allele-fraction threshold: 0.25

Splice Junction Track Options

Quality weight allele fraction




10X

* Long molecules are separated into compartments.
All molecules in same compartment share a barcode.

* Barcodes can be used to reconstruct molecules from
short read alignments (lllumina)



IGV enhancements for 10X

p252 p243  p233  p222  ple3  pls  pl32 pll2  qil2 ql23  qld42 q211  q222 q233 q242 311 q321 q323 q332 q34  q361 q37l
122kb
34,660 kb 34,680 kb 34,700 kb 34,720 kb 34,740 kb 34,760 kb 34,7
| | | | | 1 | | | | | |
[
NA12878_WGS_phased_possor | [ ©~ '
pon Coveraos oot ol Mobfintdoomal i Bl b s ;i i n i i ot s, SOt s b g,

NA12878_WGS_phased_possorted_bam.bam

Rename Track...
Copy read details to clipboard

View linked reads el View inked reads |

Group alignments by >
Sort alignments by >
Color alignments by >

Re-pack alignments

NA12878_WGS._phased_possor v Shade bfxse by quality
ed_bam.bam v Show mismatched bases
Show all bases

View as pairs

Go to mate

View mate region in split screen
Set insert size options ...

Collapsed
v Expanded
Squished

Select by name...
Clear selections

Copy read sequence
Blat read sequence

RefSeq Genes Copy consensus sequence
Sashimi Plot
W tracks loaded hr2:34,681,113 v Show Coverage Track 2M of 1,023M
Show Splice Junction Track
Hide Track
Save image...

Export Alignments...
Export track names...

Remove Track



IGV enhancements for 10X

p25.2 p243  p233  p22.2 p16.3 pis  pl32 piiz qll2 ql23  qi42 q211  q22.2 q233 q242  q311 q321 q32.3 q332 q34  q361 q37.1
122 kb
34,660 kb 34,680 kb 34,700 kb 34,720 kb 34,740 kb 34,760 kb 34,7}
| | | | | | | | | | |
[
NA12878_WGS_phased_possor | | ©~ '
bam Coverage dhior o

Haplotype “1”

Haplotype “2”

ed_bam.bam

RefSeq Genes

4 tracks loaded hhr 34,681,113 ﬁGSM of 1,023M




Viewing Variants



Variant Call Format (VCF):
File format for encoding variant sites and genotypes

The VCF specification is now maintained by the
Global Alliance for Genomics and Health (GA4GH)
- Data Working Group -2 File Formats Task Team
(http://gadgh.org/#/fileformats-team)



Viewing variants (VCF file)

Human (hg19 chr22) o) | chr22 B ch2236647,117-36,665577  Go Bt < » @ [0 = 2 | Sl
T | —
pi3 piz pil2 plll  qlld qil2l  qil.22 qi21 122 123 q13.1 q13.2 q1331 ql13.32
18 kb
36,648 kb 36,650 kb 36,652 kb 36,654 kb 36,656 kb 36,658 kb 36,660 kb 36,662 kb 36,664 kb

sample

super_pop
gender

ALL.apall.sample.phase3_shapg
_mvneall_integrated_v5a.201305
.genotypes.vef

HG00096
HGO0100
HG00103
HGO0107
HG00110
HG00113
HG00118
HG00119
HG00122
HG00128
HGO0129
HG00132
HG00137
HG00140
HG00143
HG00148
HG00151
HG00157
HG00160
HG00174
HG00178
HGo0181
HEA0185

'H

Gene

apoll_snp131.bad

[T
21097 rs6000218

[y
150610467

[y i
150610468

l
157284919

[N
1534071340

rs136151

APOL1
I
rs136154

TEHn
rs77920079

[
5713753

Il
rs136165

(R TR
rs136167 rs136176 rs1136300

[ all
152012028

[
rs79503

|4 tracks loaded thr22:36,661,537 [150M of 403M




Viewing variants (VCF file)

Human (hg19 chr22) [ | chr22 B ch2236647,117-36,665577  Go Bt < » @ [0 = 2 | [ RERNANRARAAN] (NENRANIRNES
I I e - I— | E— |
pi3 piz piiz plll  qild qil.2l  qil.22 ql2l qi22 ql23 qi3d ql13.2 qi3.31 ql3.32
18 kb
% | 36,648 kb 36,650 kb 36,652 kb 36,654 kb 36,656 kb 36,658 kb 36,660 kb 36,662 kb 36,664 kb
§§§§ ! ! I I I I I I I I I I I I I I I
282
R (F T0 IR T W TN peenerem o G veaenier ey ro i 0 0
_mvneal_integrated_v5a.201305 I I I I I I l I I I I I I Va rl a nt S Ites
.genotypes.vcf I I I I
HGO0096 | I I I T I T T TII 1T TTITT T | I
HGO0100 | | | 1 | I B N | 1N Il FHIET | | |
HGO0103 [N [ | [ | 1) Il FINET | | |
HGO0107
HG0110 i I | |
HGO0113 | | e I | Il
HGO0116 (NN I |
N I | 11 [ 1 | O I N | 1 Il FIEED | (| |
| T 1 | l [ | ] |
S | I | |
ampie TN I I [ |
il ' ! Genotypes
. . | | e |
information AN ! I |
I | [ | L]
I | | 1 | B N | 1N Il FINLT | | |
HGO0151 |
HEO0157 T | | | | I A A | 1Y Il I | (| |
HGO0160 Il | 11 1 | I N | 1N Il FHET | | |
HGO0174 [N L] | I I |
HGO0178 | I e | | | (|
HGO0181 | 1
uG0018s I I Ll | I Y N 1 I 1 | Ll | 1 L1
Gene ——a i H i N —
APOL1
O U T B B Y N T 1 T U A T T R O O R A R TN RN I Y T TR |
apoll_snp131.bad
21097 rsB000218  rsO610467 rs9610468 rs7284919 rs34071340 rs136151  rs136154 rs77020979 rs713753 rs136165 rs136167 rs136176 rs1136309 rs2012928  rs79503
|4 tracks loaded Ehr22:36,661,537 [150M of 403M



Viewing variants (VCF file)

L L TR A
o ] N IR R T B |
| | I




Viewing variants (VCF file)

H ‘ BE—— B0 B TErnmmneer (e rorem (ol (o g |
LL.apoll.sample phase3_shd
_mvncall_integrated_v5a.2013| = l I I I I I I
Zoom in here




Viewing variants (VCF file)

Red = alternate allele N [ H

Blue = reference allele L
[ [LLLLT]




Viewing variants (VCF file)

Chr:chr22
Position: 36653743
ID:rs136149
Reference: G*
Alternate: A

Qual: 100

Type: SNP

Iz Filtered Out: No

Alleles:

Alternate Alleles: A

Allele Count: 3311

Total # Alleles: 5008

Allele Frequency: 0.661142

ALL.apoll.sample phase3_shap4g
_mvncall_integrated_v5a.201305

.genotypes.vef

Variant Attributes

Allele Frequency: 0.661142
AMR_AF: 0.768

EUR_AF: 0.6282

Ancestral Allele: -|]|

Allele Count: 3311
SAS_AF:0.7832

EAS_AF: 0.7708

Number of Samples with Data: 2504
AFR_AF: 04561

Depth: 12917

Total Alleles: 5008

WT: SNP




Viewing variants (VCF file)

Cyan = homozygous
Blue = heterozygous
Grey = reference




Viewing variants (VCF file)

Chr:chr22
= Position: 36653743
[ ID:rs136149

@ 6 Genotype Information

Sample: HGOD110

-= Geanpe: ClA
Quality: -1
-= Tvp_e: HET
Iz Filtered Out: No
| ||
| |
| |
|
|




Viewing variants — sample information

Sample information

- Meta data on samples.
/ - Used for sorting & grouping

HG00096

HG00100 .

s In this example:
HG00107 p .
HG00110

HGO0O

o * sample

HGOO |

HG00122

HG00126 .

o pop

HG00132

HG00137

HG00140 [ ] S u e r O
oot per_pop
HG00148

HG00151

e e gender

HG00160

HG00174

HG00178

HG00181

HGAN1RS =




Viewing variants — sample information

Sample information is defined in an auxiliary tab-delimited file.

* First row defines the meta data column names

* First column contains sample names
(must match VCF sample names)

Example:

VCF sample
names

sample pop super_pop gender";\

HGOB096 | GBR EUR male

HG00VO97 | GBR EUR female Meta data
HGO0A99 | GBR EUR female

HG@Q100 | GBR EUR female column names
HG00101 | GBR EUR male

HG00102 | GBR EUR female

HG00103 | GBR EUR male

HCAAT AR

r~RD

FliR

mala



Viewing variants (VCF file)

Hands-on exercise

Use sample information to examine a variant that
segregates by population.

Reference:

Giulio Genovese et al.

Association of Trypanolytic ApolL1 Variants with Kidney Disease
in African Americans,

Science 329, 841 (2010); DOI: 10.1126/science.1193032

[ See handout ]




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) o} | chr22 B chr22:36,647,117-36,665577  Gol £ 4 » @ [ = 2 | Sl
I I M —emm( - | — 1 T
pl13 pl2 pll.2 plll qll.l qll.21  ql1.22 ql2.1 ql12.2 ql2.3 q13.1 q13.2 q13.31 ql13.32
18 kb

36,648 kb 36,650 kb 36,652 kb 36,654 kb 36,656 kb 36,658 kb 36,660 kb 36,662 kb 36,664 kb
1 1 1 1 | 1 | 1 | | | 1 | 1 |

| | |
ALLapot s shased_shap I III ,I IIlIIIIlIIII IIIIIIII’I I} [ |1 If IIIIIII IIIII IIIIIIIII [

super_pop

sample
pop
gander

_mvncall_integrated_v5a.20130

.genotypes.vef

HGO0098 | ] [ [ [T T T T TII I M TTTITT T [ [
HG00100 | | | (| I 1 [ | I THITT | I |
HG00103 [N IEN | | | I 1 [ | 1 FIHELT | I |
HGO0107
HG00110 L | | |
HGO0113 | | I | | | 1 11
HGO0116 [N I I 1
HGO0118 B Il | 11 (| I 1 [ | I FHIET | [ |
HGO0122 Tl | | Il [l | | | |
HG00126 1 | | |
HGO0129 T | | | | | | |
HGO0132 [ IR | | |
HG00137 | | Ini 1 I
HGO0140 Il | | | | |
HG00143 | | [ | | |
HG00148 | | | (| I 11 1| | Il FIHELT | [ |
HGO0151 |
HGO0157 il | | | I 1 [ | [ THIT | [ |
HGO0160 Il | 11 (| I 1 [ | i FHITTT | I |
HGOO1T4 [N I | | | I | |
HG00178 | | Ini | | 1 11
HG00181 | |
HGON1RE 11 | Ll [ | 1 | 1|10l 1 [N | LAl 1 1 | 1
Gene ——u 4 H i I e—
APOLA
[ NN | L T I I L (1 I 1 A O AT TY {1 W [/ L]

apall_snp131.bad
P1097 rs6000218 rs9610467  rsO610468 rs7284919  rs34071340  rs136151 rs136154 rs77920079 rs713753 rs136165 rs136167 rs136176 rs1136300 rs2012028  rs79503

4 tracks loaded thr22:36,661 537 150M of 403M



Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [} | chr22 E| APOL1: S342G |Go B « » @O = 2 | Sl =+
I f I E—— e - | E— — s —
pi3 pad pil.2 pll.l qlll qil.21  ql11.22 ql21 q12.2 q123 qi3.1 q13.2 qi331 q13.32
In th hb
n t e Sea rc OX enter 36,652 kb 36,654 kb 36,656 kb 36,658 kb 36,660 kb 36,662 kb 36,664 kb
| | | | | | | | | | | | | |

APOL1:5342G and click Go

r—vrverr—wmill (VI TCOOCTTI R0 00T R T 0 TR 1w 1y
e et 20130 | ] | I 0111 B
s | | I
HG00096 N [ I I IT T T T TINT I M TTIITT 1 II I [
: : — [ 1 w5 0A8 W =
Right-click over genotypes and select |
[N | | I

Display Mode > Squished N T ;Il T T R T

HG00128 T T |
HG00129 I ” I I I I I | I | I

2 o e | I
Right-click over genotypes and select TR | !
. | I Il | II | L 1 | |
Group By, and then attribute super_pop T ! I
HGOO174 FI T TTd [T | | 1 |
HGO0178 | | 0 nl | | | 11
HGOO181 | |
HGON18S 1 | 11 (I | 1 | 1| Il | 11 || | 1 | 1
Gene —u { 1§ I S
APOL1
T TR [ R O | A | LI 0 L I 1 L 1 O O (Y O TN T W [/ 1]
- : 21097 rs6000218 rs9610467 rs9610468 rs72849190 rs34071340 rs136151 rs136154 rs77020979 rs713753 rs136165 rs136167 rs136176 rs1136309 rs2012928 rs79503

l4 tracks loaded | enr22:36,661,537 I |[150M of 203m




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [ | chr22 B} chr22:36,661,887-36,661,927 Co B « » @ MO = 2 | Elereeeereeeerrrerig
I T —— e - |
pi3 piz piiz pllil  qlll qil.21  qil.22 ql2l qi2.2 ql23 qi3d ql3.2 qi331 ql3.32
41bp
2 i 36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,920 bp
§§§§ I I I I
AMR i
-
| |
SAS .
|
I
i
AFR L
Sequance - C ACGGATGTGGC CCGCC CC CTGTAATGC CTTCGCTTTCTTGTGCTGGATG
T ) vV A p V S F F L vV L D
Gene
APOL1
apol_snp131.bed = L
rs16996616 rs73885319
14 tracks loaded ﬁhr22:36.661 916 139M of 523M



Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) | | chr22 B | APOL1:S342G |co & « » @ 0O = 0 | gt &
I ; I —— e T | — | ] | — ) —
pi3 pd piL pill  qlld qi121  qi1.22 a121 a2z q123 q131 a13.2 q1331 ql1332

18 kb

I n t h e S e a rc h b OX e nte r 36,652 kb 36,654 kb 36,656 kb 36,658 kb 36,660 kb 36,662 kb 36,664 kb

APOL1:5342G and click Go  |EiimiTinERmRTENT My SAm | Vih A v
-l ||||||||||I|I|||||||=| |} I ""”'f""l” ||I|I||||I|||| T

T T
_mvneall_integrated_v5a.201305 I I I

.genotypes.vef

HG00098 Bl
HGO0100
HGO0103 11
HG0O0107
HGO0110 111
HG00113
HG001186 11l
HGO0119
HG00122 11l
HG00126
HGO00129 111
HG00132 11l
HGO0137
HGO0140 11l
HGO0143
HGO0148 | |
HGO0151
HGO0157 [N |
HGO0160 I | 1
HGOO174 [HINEN | | | |
HG00178 | 1
HGO0181 | 1
HGON18S 1 | 11 (I | 1 | 1 11 [ | || | 1 | 1

H i I ——
APOL1
I A e T B I nemne I U L 1 I I (T AT AT VY I {11 [ 1 L1l
21097 rs6000218 rsO610467 rs9610468 rsT284919 rs34071340 rs136151 rs136154 rs77920979 rs7T13753 rs136165 rs136167 rs136176 rs1136309 rs2012928 rs79503

|4 tracks loaded ﬁhr22:3-6,661,537 [150M of 403M

i

Gene

apoll_snp131.bad




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [ | chr22 B} (chr22:36,661,887-36,661,927 Go B « » @ MO = 2 | Elvrreeeeereeren i

5 I 55555 S 5

T I | 1 | —
pl3 pl2 pll.2 plll qll.1 qll.21  ql1.22 ql2.1 ql2.2 ql2.3 ql3.1 ql3.2 ql13.31 ql3.32

41bp
36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,920 bp
| | |

sample
pop
super_pop

| [
ALL.apolt.sample.phasa3_shap .

_mvncall_integrated_v5a.201305
.genatypes.vef

HGO0096
HG00100
HG00103
HGO0107
HGO00110
HG00113
HGO0116
HGO00119
HG00122
HGO00126
HG00129
HG00132
HG00137
HG00140
HG00143
HGO0148
HGOO0151
HGO0157
HGO0160
HGO0174
HG00178
HG00181
HGOO185
Sequence - C ACGGATOGTGSGE CCCTCTGTAAGTECTTOCTTTUCTTSGTGC CTGOGATG
T D V A P N S F F V L D

Gene

[ > | [ > |
16996616 1573885319

|4 tracks loaded hhr22:36,661 907 197M of 438M

apol_snp131.bad




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [ | chr22 B (chr22:36,661,887-36,661,927 |Go Fr « » @ [ = 2 | RNy |
I T e —e 1 | e e |
pl3 pl2 pll.2 plll qll.1 qll.21  ql1.22 ql2.1 ql2.2 ql2.3 ql3.1 ql3.2 ql13.31 ql3.32
41bp
P %; 36,661,800 bp 36,661,900 bp 36,661,910 bp 36,661,920 bp
5 &5 I I 1 I I
1g
[ [
ALL.apal1.sample.phase3_shap: .
_mvncal_integrated_v5a 201308
.genotypes.vcf
HG00098 Il
HG00100 ALLapoll.sample.phase3_shapeit2_mvncall_integrated_v5a.20130502.genotypes.vcf
HGO0103
HGO0107 Rename Track...
HGO0110

Change Font Size...

Right-click over genotypes and select S Hile Frequency

Display Mode > Squished S

T TS T

HGO0140 / Quality
HG00143 il
HGo0148 Group By...
HG00151

HGO0157 Display Mode
HG00160 Collapsed
HG00178

He00151 v Expanded
HGOO185

Change Squished Row Height...

Sequence - C ACGGATUGTGGTCTCTCC T Suppress Filtered Sites G G A TG
Set Feature Visibility Window...

Gene

= Save image...
Export Features...
Export track names...

apol_snp131.bad
516906616

Remove Track
j4 tracks loaded hr22:36,661,807 197M of 498M




Viewing variants (VCF file)

Hands-on exercise

_muncall_integrated_v5a.201305

.genotypes.vef

Human (hg19 chr22) [BJ  chr22 B chr2z36,661.887-36,661,927  Go Y <« » @ [ = 2 | g =
I 1 | — | 5 I s E— v E—
pl13 p12 pl1.2 plll ql1.1 qll.21 ql1.22 ql2.1 ql2.2 ql12.3 ql3.1 q13.2 ql3.31 ql13.32
41 bp
3 i, 36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,020 bp
4 i§ I I I I I
383
S— S—
ALL apol1.sample.phase3_shapq L L —

I | |

0 O ||| 1N |

|
Sequence -
Gene
apol_snp131.bed
rs16096616 rs73885319
14 tracks loaded hr22:36,661,903 12M of 498M




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [BJ  chr22 B chr2z36,661.887-36,661,927  Go Y <« » @ [ = 2 | g =
T I T el [T [ —— | 5 I s E— v E—
pl13 p12 pl1.2 plll ql1.1 qll.21 ql1.22 ql2.1 ql2.2 ql12.3 ql3.1 q13.2 ql3.31 ql13.32
41 bp
3 i, 36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,020 bp
4 i§ I I I I I
383
S— S—
ALL apol1.sample.phase3_shapq L L —

_muncall_integrated_v5a.201305

.genotypes.vef

ALL.apoll.sample.phase3_shapeit2_mvncall_integrated_v5a.20130502.genotypes.vcf

| Rename Track...
— Change Font Size...

Color By

Right-click over genotypes S A requency

Allele Fraction

and select Group By Sortly Cenotype
Sort By Qual

Croup By...

Display Mode
Collapsed

v Squished
Expanded

y

Change Squished Row Height...
— Suppress Filtered Sites
— Set Feature Visibility Window...

Sequence C ACGGATGTGGT CTCTCTCTG . A T G
Save image...
Gene Export Features...
Export track names...
| |
apol_snp131.bed
516096616 Remove Track

14 tracks loaded hr22:36,661,903 12M of 498M




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [BJ  chr22 B chr2z36,661.887-36,661,927  Go Y <« » @ [ = 2 | g =
T I ——  —eal [ - | — | 5 I s E— v E—
pl13 p12 pl1.2 plll ql1.1 qll.21 ql1.22 ql2.1 ql2.2 ql12.3 ql3.1 q13.2 ql3.31 ql13.32
41 bp
3 i, 36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,020 bp
§§§§ I I I I i
m— m—
ALL apol1.sample.phase3_shapq L L
|
_mvncall_integrated_v5a.201305
.genotypes.vef
o Group By Attribute

v None
sample
‘* pop
— gender r

Group tracks by:

.|

| [T

[0 N BN [ (fewenN ]
[ ___THN

Select attribute super_pop -7
BN =

Sequence - CACGGATGTGSGESECCCTCTGTAAGECECTTOCTTTO CTTGTGO CTUGSGATG

0T

Gene

apol_snp131.bed

rs16096616 rs73885319

14 tracks loaded hr22:36,661,903 12M of 498M




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [ = chr22 B ch2236,661,887-36,661,927 Go FY « » @ [ = 2 | el =
1 5 555 A 1 —
p13 p12 pll.2 plil qll.l qll.21  ql1.22 q12.1 q12.2 q12.3 q13.1 q13.2 q13.31 q13.32
41bp
% i; 36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,920 bp lﬂ
| | | | |
m§§§ y A
— —
ALL.apol1.sample.phase3_shap — — —
_mvncall_integrated_v5a.201305
.genotypas.vcf
Scroll down to
EAS
AMR
Sequence - CACGGATGTGGTCC C TGTAAGCTTOCTTTOCTTGTGOCTGGATG
- .
Gene
apol_snp131.bed
rs16996616 rs7T3885319

{4 tracks loaded hr22:36,661,901 M of 438M




Viewing variants (VCF file)

Hands-on exercise

Human (hg19 chr22) [ | chr22 B} chr22:36,661,887-36,661,927 Co B « » @ MO = 2 | Elereeeereeeerrrerig
I T —— e - |
pi3 piz piiz pllil  qlll qil.21  qil.22 ql2l qi2.2 ql23 qi3d ql3.2 qi331 ql3.32
41bp
2 i 36,661,890 bp 36,661,900 bp 36,661,910 bp 36,661,920 bp
§§§§ I I I I
AMR i
-
| |
SAS .
|
I
i
AFR L
Sequance - C ACGGATGTGGC CCGCC CC CTGTAATGC CTTCGCTTTCTTGTGCTGGATG
T ) vV A p V S F F L vV L D
Gene
APOL1
apol_snp131.bed = L
rs16996616 rs73885319
14 tracks loaded ﬁhr22:36.661 916 139M of 523M



Other Tools



Tools

« Combining numeric data tracks

 BLAT



Combining numeric data tracks

GM12878 HIK2Tme3

GM12878 H3K36me3

GM12878 H3K4me1

p15.31 pl51 pldl pl32 pl2 qll.2 ql2.2 ql3.3 ql43 ql5 q21.2 q22.2 q23.2 q311 q31.3 q33.1 q333 q351 q35/
121 kb
67,400 kb 67,420 kb 67,440 kb 67,460 kb 67,480 kb 67,500 kb
| | | | | | | | | | |
[-25)
GM12878 H3K27ac

T Y R R YT [ IS P ST TR T P P E e T | -Ll o ek sl miie l—-‘dJ—l.-J-—ll.l—l O | h.l N T S Y VR S U I N STt

[0-25

T TRPRTS ¥ [ R PRI L W NS TPURP PR W T T ) R (T R UNT U TTT PR IE YT 1117 VU DY ARSI ST TP TRRPer U | W YT 1 Ty
[-23

PRI P YR TR T 1Y T I RPTI JT F ST N O | P h.ll.a.l..n [T | Ll.l.u.l. - ol JLI‘.&.“JJL“ nL“-hﬂmlﬂ [T TR T [ PSR I TP
[-25

T T l..h.nm;ilm;ul T T AT [TH I SR S I TR | .h‘_d bosihis det o dlimos m.hh_u PRy T ey |




Combining numeric data tracks

.
e — _;‘ Select Tools > Combine Data Tracks e —

Run igvtools...
Find Motif... L)

5400 kb 67,420 kb 67,440 kb 67,460 kb 67,480 kb 67,500 kb
BLAT ... . | | | | | | | | | |

Combine Data Tracks

GitOOIS Heatmaps » . H-LI. [ IR W S S W A T T ] -Ll o ek smd e l—-“A—l.-J-—l b b e s .L-.Hﬂhh‘.ﬂ..h Y Y P R I N St

BEDTools > .

T TRPRTS ¥ [ R PRI L W NS TPURP PR W T T ) R (T R UNT U TTT PR IE YT 1117 VU DY ARSI ST TP TRRPer U | W YT 1 Ty
[-23

GM12878 H3K36me3

PRI P YR TR T 1Y T I RPTI JT F ST N O | P h.ll.a.l..n [T | Ll.l.u.l. - ol JLI‘.&.“JJL“ nL“-hﬂmlﬂ [T TR T [ PSR I TP
[-25

GM12878 H3K4me1 || ‘II | l
aanh. ooiteo dade Jjﬂhhul. TV TANUAEY [TR I Oy A i T l.h‘-.‘ bosihis det o dlimos I Y P PR YU |




Combining numeric data tracks

1. Select two tracks from
the dropdown menus

e tracks

2. Select the operation:

\ Track A: | GM12878 H3K27ac

*  Add

Operation:| Add

. « Subtract

* Multiply

Track B: | GM12878 H3K27me3

d « Divide

Result Track Name

Sum|

)

L

3. Name the new combined track

| Cancel |




Combining numeric data tracks

I |
pl1531  pl51 pldl pl32 pl2 qll.2 ql22 ql3.3 ql43 ql5 q21.2 q22.2 q23.2 q31.1 q313 q331 q333 q35.1 q35.

121 kb

67,400 kb 67,420 kb 67,440 kb 67,460 kb 67,480 kb 67,500 kb
| | | | | | | | | | | |

TeckA | W
ek i s dmb M T TP PO VR S PSSO TR |5 | NS [P SO hl [ W S Y YR S { R I S SR

Track B

TR Y T S P T W AN IR PR TR T R SR R TW RTUTI [IT PRRPot R 1T S DUV PR RO TP PR TIRre o O | WY1 e

GM12878 HIK 3

RPTR FFY  TIP U T YT P TR T T T P h.ll..l.l...lhlllLl_l caad h L.LI.-LI. -l .udl.l.lh-“.ldl.n. -LJI-I-‘.I.JI.IJI..I [T TR AT T [ TR T I T
[0- 25

NeW traCk - A + B .ﬂmﬂjﬂhhm. YO TR FTR gy A B TR, l.hl_d NIFTTIFOIUY T m.hh_u amenns i adalndon o L




BLAT

GenomeSpace Go

Run Batch Script...
Run igvtools...

__Find Motit . * Use a BLAT server to do search for
BLAT ... J : .
alternative alignments for

~ Combine Data Iracks 1
g o any feature or sequence read, or
o user-entered sequence.

—

« User-specified server or
UCSC (volume limits apply).



BLAT example

p36.23 p36.12 p35.1 p34.1 p32.2 p31.2 p223 p21.3 pl133  pl2 ql1 ql2 q21.1 q22 q24.1 q25.2 q31.1 q32.1 q323 q4211 q423 q44
3,008 bp
114,175,000 bp 114,176,000 bp 114,177,000 bp
| | | | |
{0,109
! l |
e AT i ’ o L g ) . { i .
o 1 i —— i .
| |
| | " i 1 ; "
1 ! \" 'I ' 1 ! 1
| | , (- . ot i ! o ) —f—!. i -
L i , : ) = 'y,
: : i | — Lt i . ' ' )
1 1 - —— T 1 1 1
. , | e— L g , — S, . 0" . i | e |
1 1 1 1 1 1
U U L 1 . II 1 1
I | ! : o | K
= e, — | e = o
|I ' L 1 ! 1 3 ! 1 ill 0 h—————— U ,I —
T . ‘ = / I . X i
[y — ol H : i . . ' | . ;
| [ | . ' )
. | : : | — o |- | |
1 1 1 I|
1 1 1 . —_— 1
: : i} : —! - I !
; o1 n | }— " (-
1 1 l‘ " 1
= ' - o = ' ; ,
i D r— - )
_I II ! ,
| e J |
|II I.
!
i
|




BLAT example

p36.23 p36.12 p35.1 p34.1 p32.2 p31.2 p22.3 pl133  pl2 ql1 ql2 q21.1 q22 q24.1 q25.2 q31.1 q32.1 q323 q4211 q423 q44
I tigate thi Kk -
nvestgatle nisS pea 114,176,000 b 14177000
| | |
{0,109
! |
g g [ ’ o ! I
| b | 'l,..; | > .:- . A0 . oo N :
1 1 y 1 1 1
- |
: T o ! L
! 1 1 ! ' 1 1 ' | ! r 1 'I L | I' L ! II 1
U | Lo - | (8 | b 0 | |
' . = | ., == . L — . . L
' i T ; ] ! i "o
- I ————
o " ' ) ' q : = 0 ' P —
- [ | T ! i | ' ) '
L L 1 | 'I U | | | dl Pl T 11 1 1 N l_I i Y L
| : | — : (R | |
i | AR ) '
1 1 . —_— 1
: : i} : —! ' | ot !
; (i S ] a— L (o '
| ™ ' i
= - L = ; o
i . r— - ) -
_I 1 ]
| e J : |
1 Il J




BLAT example

p36.23 p36.12 p35.1 p34.1 p32.2 p31.2 p223 p21.3 pl133  pl2 ql1 ql2 q21.1 q22 q24.1 q25.2 q31.1 q32.1 q323 q4211 q423 q44
I tigate thi Kk
nvestgatle nisS pea 114,176,000 b 14177000
| |
{0,109
. |
| |
'—ll i . |
1 : 15 T \II L
| U 1
| 0l ' |
: ”I L I' L II 1
1 I!' k II [ 1 1
" L | 'I " L 1 ‘I'I '
| '
. = ' ! ' ;
| | L vl o
1 1
II L} 1
| |
oo e L
P, e m— .
1 L o
1 I|
| i | — : "
| — | I ! )
' - i = | , : | — !
\ i | | | > i
'
= ' - o = ' ; -
i D r— - )
_I 1 ' ]
| e J I : |
1 II l.
!
i
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BLAT example

[
| p3623__ p36.12_ p35d__ p3al __p322  p3l2 B B 3" p12 qll  ql2 q2I1  q22 G241 q25.2 q3L1 321 q323 q4211 q423 o4

Rig ht-Cl iCk On a read a nd 800 bp e 114,176,000 bp 114,176,200 bp 114,176,400 bp 114,176,600 bp

select BLAT read sequence . — . =

i
| NA12878 WGS

.
Rename Track... |
I . | Copy read details to clipboard { [
] | ;
+ Group alignments by !

Sort alignments by
Color alignments by

vwvyy

| v Shade base by quality
. | ' v Show mismatched bases |
| Show all bases

B imm 5 -
View as pairs
Co to mate

View mate region in split screen
Setinsert size options ...

=
An

4 Re-packalignments
| Il v Show coverage track
- Show junction track
Load coverage data...

Collapsed
v Expanded
'+ Squished

Select by name...
Clear selections

Copy consensus sequence
Blat read sequence

Sashimi Plot

1 Remove Track

Save image...




BLAT example

e O O
File
BLAT result for query sequence:
TAATGCACACGAACTCCATTAGGTATTCATATGGGTTGAAAAGGGGGGTTAACTTGGCCTAAATAGAAAATGTCTTCTCATCATTTTTT
Click on a row to go to alignment
chr start end strand score match mis-match rep. match N's Q gap co... Qgap ba.. Tgapco.. Tagapba..
chré 1552157 1552307 - 536 142 8 0 0 0 0 0 0
chrl 401076... 401078... - 492 147 19 0 0 2 9 16
chr2 715213... 715215... + 456 137 22 0 0 0 0 1 1
chrl3 525933... 525935... + 444 135 23 0 0 0 0 1 1
chrl7 5468054 5468211 + 440 128 16 0 0 1 12 1 13
chrl0 933987... 933989... + 436 132 22 0 0 0 0 1 1
chrls 956086... 956088... - 428 129 20 0 0 0 0 2 4
chrs 166236... 166238... + 424 126 18 0 0 0 0 2 4
chr3 102995... 102996... + 424 124 15 0 0 1 5 2 9
chrl7 708930... 708932... - 420 130 24 0 0 0 0 1 1
chrl2 571299... 571301... - 420 135 27 0 0 1 1 2 4
chrs 665088... 665089... + 420 136 31 0 0 0 0 0 0
chr9 915725 915886 + 416 127 21 0 0 0 0 2 13
chr2 223622... 223622... + 400 120 17 0 0 1 11 2 13
chrl9 583386... 583388... - 396 124 24 0 0 0 0 1 1
chrl6 574045... 574047... + 392 118 16 0 0 2 29 2 8
chrl 171497... 171497... + 388 114 16 0 0 0 0 1 1
chrl0 101042... 101042... - 384 111 13 0 0 0 0 2 7
chr2 228547... 228547... + 384 116 19 0 0 0 0 1 1
chrl 202874... 202875... + 384 120 23 0 0 0 0 1 1
chrl 549438... 549439... + 384 119 22 0 0 0 0 1 1
chrl2 570020... 570021... - 380 113 17 0 0 0 0 1 1
chr4 878470... 878471... + 376 119 22 0 0 0 0 3 6
chr2 145618... 145619... + 376 110 11 0 0 3 38 2 40
chrl 7404808 7404937 + 372 109 15 0 0 0 0 1 5
chrl 247194... 247194... - 368 106 12 0 0 0 0 2 6

e ————————————



BLAT example

[2Hala)

Many alternative alignments

Wlth S I m I I a r S C O re S LTTGAAAAGGGGGGTTAACTTGGCCTAAATAGAAAATGTCTTCTCATCATTTTTT

—p—

chr start end strand score match mis-match rep. match N's Q gap co... Qgap ba... Tgapco... Tagapba..
chré 1552157 1552307 - 536 142 8 0 0 0 0 0 0
chrl 401076... 401078... - 492 147 19 0 0 2 9 3 16
chr2 715213... 715215... + 456 137 22 0 0 0 0 1 1
chrl3 525933... 525935... + 444 135 23 0 0 0 0 1 1
chrl7 5468054 5468211 + 440 128 16 0 0 1 12 1 13
chrl0 933987... 933989... + 436 132 22 0 0 0 0 1 1
chrls 956086... 956088... - 428 129 20 0 0 0 0 2 4
chrs 166236... 166238... + 424 126 18 0 0 0 0 2 4
chr3 102995... 102996... + 424 124 15 0 0 1 5 2 9
chrl7 708930... 708932... - 420 130 24 0 0 0 0 1 1
chrl2 571299... 571301... - 420 135 27 0 0 1 1 2 4
chrs 665088... 665089... + 420 136 31 0 0 0 0 0 0
chr9 915725 915886 + 416 127 21 0 0 0 0 2 13
chr2 223622... 223622... + 400 120 17 0 0 1 11 2 13
chrl9 583386... 583388... - 396 124 24 0 0 0 0 1 1
chrl6 574045... 574047... + 392 118 16 0 0 2 29 2 8
chrl 171497... 171497... + 388 114 16 0 0 0 0 1 1
chrl0 101042... 101042... - 384 111 13 0 0 0 0 2 7
chr2 228547... 228547... + 384 116 19 0 0 0 0 1 1
chrl 202874... 202875... + 384 120 23 0 0 0 0 1 1
chrl 549438... 549439... + 384 119 22 0 0 0 0 1 1
chrl2 570020... 570021... - 380 113 17 0 0 0 0 1 1
chr4 878470... 878471... + 376 119 22 0 0 0 0 3 6
chr2 145618... 145619... + 376 110 11 0 0 3 38 2 40
chrl 7404808 7404937 + 372 109 15 0 0 0 0 1 5
chrl 247194... 247194... - 368 106 12 0 0 0 0 2 6

e ——————————



For further information and help
|GV web site: www.igv.org
User forum: groups.google.com/group/igv-help
Source code: github.com/igvieam

Please cite your use of IGV
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